CASE 15

Will They Populate the Boxes?
Piloting a Low-Tech Method for Capturing Executive E-mail and a Workflow for Preserving It at the University of Michigan

AUTHOR: APRILLE COOKE MCKAY
University Archives and Records Programs
Bentley Historical Library, University of Michigan
aprille@umich.edu

PAPER DATE: May 2013

CASE STUDY DATE: May 2008‒July 2012

ISSUE: The first part of the paper describes a pilot study testing whether university executives and leaders would flag e-mail messages of long-term value to transfer to the archives. The second part describes the steps taken to move from an ad hoc approach to digital records transfer and processing to one much more routinized.

KEYWORDS: Motivating and enabling executives to select correspondence of long-term value is an important aspect of the implementation of many recordkeeping technologies. This study describes a pilot to determine whether executives in the University of Michigan environment would or could identify archival value messages and share them with the archives. The Bentley Historical Library’s new plan and workflow for describing, processing and storing e-mail records for future access is also described.

Copyright by Aprille Cooke McKay.

Archivists at the Bentley Historical Library who contributed to this project included Nancy Bartlett, Francis X. Blouin, Nancy Deromedi, Gregory Kinney, Michael Shallcross, William Wallach, and Brian Williams. Collaborators from Information Technology Services and the University Library included Margaret Bennett, Jose Blanco, Ezra Brooks, Paul Courant, Cathy Curley, Aaron Elkiss, John Gohsman, Mary Gohsman, Kat Hagedorn, Michael Loviska, James Ottaviani, Laura Patterson, Christina Powell, Kim Rinn, Cory Snavely, Daphne Wakefield, and John Weiss.
Background

This is the second case study related to the efforts of the University of Michigan’s Bentley Historical Library to capture and preserve the e-mail correspondence of long-term value created by university leaders. The first case study, “Case 14: Partnering with IT to Identify a Commercial Tool for Capturing Archival E-mail of University Executives at the University of Michigan,” detailed the unsuccessful effort to identify and implement off-the-shelf software to capture and preserve e-mail from the diversity of e-mail servers and services then in use at U-M. It also described the team’s efforts to persevere with the project despite the concurrent overhaul of IT organization at the university (Phase 1). This study describes the second and third phases of the project, in which we tested whether executives would select messages of long-term value for the archives (Phase 2), and developed a digital processing plan and workflow (Phase 3).

A more complete background summary is given in the first case study, but an essential aspect to reiterate is the extensive diversity of e-mail choices then offered to employees at the U-M. When this study began, some schools and colleges on campus ran their own Exchange servers. These servers were traditionally independent of each other and on different upgrade schedules, and they therefore ran different versions of Exchange. During 2009 and 2010 several of the Exchange “forests” were combined and upgraded.

In addition to Outlook/Exchange, the university also offered a generic IMAP service, based on Carnegie Mellon’s Cyrus IMAP e-mail system, and supported a variety of desktop e-mail applications to access it, including Mulberry, Apple Mail, Pine, Thunderbird, Entourage, and two home-grown webmail applications. Users could choose one desktop or web-based e-mail application for an office computer, and a different one for a home computer or PDA. In addition, no policy barred employees from forwarding their e-mail to a third-party service such as Gmail, and many employees did choose to do so.

In early 2010, as the second phase of this project began, there was a growing acknowledgment by University leadership that the multiplicity of e-mail tools was inefficient and inhibited interdisciplinary collaboration. While leaders strategized about whether to move e-mail services to a cloud vendor, the project team embarked on the next two phases of the project. In Phase II, the team tested whether well-motivated executives and faculty members would nominate archival-quality messages on-the-fly; and in Phase III, it created policies, workflow and tools to store and provide access for captured digital records.

During Phase I of the project (see “Case 14: Partnering with IT . . .” by Aprille Cooke McKay, 2013), the team had defined the project’s initial scope:

- Target prospective e-mail, rather than legacy accumulations.

---

1 The project, “E-Mail Archiving at the University of Michigan” was generously funded beginning January 1, 2010, by the Andrew W. Mellon Foundation. Within the U-M, the project was called “Me-mail.”
• Include both the academic and non-academic functions of the university:
  o Focus on university decision-makers, rather than rank-and-file employees, but also include select “star-quality” faculty members; and
  o Exclude the health system, athletic program and general counsel’s office.

During Phase I, these selections provided a target population of 1,500 potential record donors. Serving 1,500 users might have been feasible for a large, automated system, but the RFP for off-the-shelf software had been withdrawn, and we realized that any alternative would have to be smaller and more focused on the most important university leaders. We believed we could fill important gaps in the correspondence series coming to the archives if we could capture the archival-quality e-mail of 50 executives, primarily deans and executive officers.

We felt that our approach would need to be highly customized for each executive. U-M policies do not explicitly require the preservation of dean’s correspondence for the archives—typically, the archives has negotiated transfer of records through persuasion. Our target population had therefore been used to a high degree of control over their e-mail records.

Another assumption was that we would need the conscious cooperation of the executives to declare archival records. Unless our users were willing to archive all of their e-mail, or to entrust the filtering of e-mail with keywords alone, donors would have to make decisions about whether particular messages were worthy of being preserved permanently. Automated selection would have been ideal, but unfortunately, during Phase I of the project, we learned that the technology for reliable auto-classification of records has not emerged from the beta stage. Experience had also shown us that at the end of their tenures, most officials do not have the interest, time or energy to search through accumulated e-mail to decide what should be turned over to the archives or to a successor. We hoped that it would be less burdensome nominate messages for preservation in real time, as the work was being done.

Therefore, we decided to test whether our target population would be willing or able to preserve particular messages on the fly, making decisions to capture them in a record-keeping system outside of their own mailboxes as the messages were read, sent, or received. We resolved to conduct a series of pilots with several officers and faculty members, selecting people who had a deep understanding of the value of archives and the historical record. We resolved to work with them to determine whether they would participate in records declaration. This work would comprise Phase II of our work.
Phase II: Piloting the “Copy Method”

To test whether executives would nominate record messages, we undertook the following steps:

1. **Inventing the “Copy Method”**

During our original user interviews, we had asked whether donors would be willing to forward particular e-mail messages to the archives for management. A few of our users thought that this might work. After brainstorming with archival and technical colleagues, we set upon what we thought would be a simple and effective technique based on this idea. We called it the “Copy Method.”

The Copy Method utilized a second, personal account that was created for each individual whose e-mail archivists wanted to collect. This account used the characters “bhl-” (for Bentley Historical Library) prepended to the person’s existing e-mail address. Thus, Francis Blouin’s “fblouin@umich.edu” account was linked to an archival account “bhl-fblouin@umich.edu.” Both the donor and an archivist were provided privileges to view and download message from the archival account.

Messages destined for this repository could be cc’ed or forwarded through the e-mail system by the owner of the parent (i.e., non-archival) account, or by his or her colleagues. In addition, most e-mail messaging programs could be induced to display the second account as if it were a folder in the primary account. This would allow the donor to drag and drop messages into the archival account directly from their regular e-mail reader, without needing to forward messages. Furthermore, the donor had the ability to set up folders within the archival account, so they could further differentiate the mail intended for the archives, if so desired.

During our conversations with donors, we learned that several worried that they might forward a message that they later wished to withdraw. For example, a message might seem to embody a final decision at the time it was sent, but the decision might be amended at a later time. Decision makers wanted to be able to rescind messages from the archives. To allay these concerns, account owners and their designees were provided permission to delete messages in the archival account.

---

2 See “Case Study 14: Partnering with IT to Identify a Commercial Tool for Capturing Archival E-mail of University Executives at the University of Michigan” at [http://files.archivists.org/pubs/CampusCaseStudies/CASE-14-FINAL.pdf](http://files.archivists.org/pubs/CampusCaseStudies/CASE-14-FINAL.pdf)
We planned to allow mail to accumulate in the accounts for a time, after which the archivist would secure permission to download the messages from the executive and preserve them permanently. Usually, mail accounts at the university must be affiliated with real people as a matter of policy. Since the archival accounts were primarily affiliated with a particular person, and since they were not allowed to send mail, but only to receive it, the e-mail administrators consented to our scheme.

Since this was a pilot, and we were unable to assure the preservation of e-mail transferred to the account (since the mechanisms were being simultaneously developed), we decided to ask pilot users to transfer copies of messages (instead of “original” messages) to the archival account.

2. Testing the “Copy Method”

Since U-M employees could use a variety of e-mail applications at the time of the pilot, we needed to thoroughly test this approach in all applications before we presented it to pilot users. Testing took place among two major groups: IMAP users and Exchange users. We began testing the IMAP applications first because the Exchange forests were in the process of being consolidated and upgraded.

To assess the suitability of the Copy Method, we developed a detailed protocol, testing account setup; features such as copying, forwarding, search, deletion, drag-and-dropping;
and configuration steps such as adding assistants and creating rules so mail would be sorted into the account automatically. As we worked, we took screenshots of the appearance and functionality, and we reflected on usability of the application. (See Appendix 1–Test Protocol for Apple Mail on page 18; and Appendix 2–Test Protocol for Outlook on page 26.)

We set up archival accounts for six Bentley archivists and tested the technique using Pine, Apple Mail, Mulberry, UM Webmail (Blue version), UM Webmail (Maize version) and Thunderbird. We learned that while the technique worked on a fundamental level with all of the applications, it was not easy to use in Pine and Webmail Maize. Furthermore, there were important differences in how the functionality worked in different applications. For example, to move copies of messages rather than originals, different key combinations were necessary. The setup procedure varied with each application, so we learned that it would be important to conduct setup in the mailbox owner’s office, and separately on each computer that the mailbox owner used to read his or her mail.

We tested Exchange-based e-mail applications next—Outlook, Entourage, and Outlook Web Access. Setup with the Exchange applications was more arcane than with the IMAP ones. It was even more important to set up these applications at deskside.

We also tested whether these different applications produced differing behaviors from the archivist’s point of view. The person fulfilling the “archivist” role maintained two e-mail accounts: one on the IMAP server and one on the largest campus Exchange server. Again, because of the policies surrounding e-mail accounts, the archivist’s access had to be tied to a specific person, rather than to a role. While we deemed this acceptable for pilot tests, we planned to seek an exception to the policy if the technique proved successful and wider application was adopted. Creating role-based access (say, “university archives”) would allow institutional access to the archival records if the responsible archivist were to be hit by the proverbial bus.

3. Training

Using the lessons learned from putting the different messaging applications through their paces, we developed setup guides for each application with screenshots and management tips that were appropriate for each software. (See Appendices 3–10, Setup Guides for Entourage, Apple Mail, Mulberry, Outlook 2007, Outlook 2010, Outlook 2011, Pine, and Thunderbird on pages 36–71.) Since the university archives team members had not previously done software training, we arranged for members of the Information Technology Services (ITS) education team to give advice about the best way of training deans, directors, and department heads to use the Copy Method.

They advised that we should be prepared to give a short (less than 30 minutes) desk-side session that would outline the goals of our project, describe the types of messages that the archives was interested in receiving, allow us to set up access to the mailbox from within their mail application, and let them move a few test messages into the box, and pull them out again. They also advised that it would be useful to prepare a customized card or “job
aid” to help them remember the name of their e-mail account and how to use it. (See Appendix 11–Example Job Aid [page 72], which was printed on both sides of a quarter page of blue cardstock.)

Based on these recommendations, we prepared a script for two archivists to conduct the training—one would talk about the types of records to be selected for the archives and the other would do the mailbox setup and show the donor how to use the system. (See Appendix 12–MeMail Introduction Outline, page 74)

Next, we conducted practice training sessions with members of the Bentley’s own staff, again using different e-mail applications, and received critiques that we used to revise the script. Finally, we were prepared to begin the pilots.

4. Recruiting and Training Pilot Users

We recruited and trained eleven pilot users, including the offices of the Provost, Vice President for Government Relations, Assistant Dean of the A. Alfred Taubman College of Architecture and Urban Planning, and Vice President for Research, as well as the Director of the Bentley Library. We also recruited three “star” faculty members to capture scholarly correspondence. These users were, in general, people with whom the archives had good relations and who had a pre-existing commitment to see records of historical value come to the archives. For each, we trained the office holder and his or her assistant, if desired, about how the system worked.

<table>
<thead>
<tr>
<th>Application</th>
<th>Number of pilot users</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pine/Webmail Blue</td>
<td>1</td>
</tr>
<tr>
<td>Thunderbird</td>
<td>4</td>
</tr>
<tr>
<td>Webmail Blue</td>
<td>1</td>
</tr>
<tr>
<td>Outlook</td>
<td>2</td>
</tr>
<tr>
<td>Gmail</td>
<td>1</td>
</tr>
<tr>
<td>Mulberry (switched to Outlook)</td>
<td>1</td>
</tr>
<tr>
<td>Apple Mail</td>
<td>1</td>
</tr>
</tbody>
</table>

Over the course of the next few months, we sent reminders to pilot users to continue to use the system, and to offer support if there were troubles.
5. Compiling the Results of the Pilot

We were disappointed that the yield on the boxes was low.

<table>
<thead>
<tr>
<th>Title</th>
<th>Pilot start</th>
<th>Pilot end</th>
<th>Number of messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vice President for Governmental Relations</td>
<td>Apr. 2010</td>
<td>Dec. 2011</td>
<td>235</td>
</tr>
<tr>
<td>Associate Vice President for Research Cyberinfrasstructure</td>
<td>Mar. 2011</td>
<td>Dec. 2011</td>
<td>4</td>
</tr>
<tr>
<td>Director of the Residential College</td>
<td>Feb. 2011</td>
<td>Dec. 2011</td>
<td>2495</td>
</tr>
<tr>
<td>Vice Provost for Academic Information</td>
<td>Jul. 2010</td>
<td>Dec. 2011</td>
<td>105</td>
</tr>
<tr>
<td>Assistant Vice Provost for Academic Information</td>
<td>Jul. 2010</td>
<td>Dec. 2011</td>
<td>102</td>
</tr>
<tr>
<td>Director, Bentley Library</td>
<td>Apr. 2010</td>
<td>Dec. 2011</td>
<td>105</td>
</tr>
<tr>
<td>Provost staff</td>
<td>Jul. 2010</td>
<td>Dec. 2011</td>
<td>42</td>
</tr>
<tr>
<td>Professor 1</td>
<td>Jul. 2010</td>
<td>Dec. 2011</td>
<td>13</td>
</tr>
<tr>
<td>Professor 2</td>
<td>Aug. 2010</td>
<td>Dec. 2011</td>
<td>0</td>
</tr>
<tr>
<td>Professor 3</td>
<td>Jul. 2010</td>
<td>Dec. 2011</td>
<td>2</td>
</tr>
<tr>
<td><strong>Total messages:</strong></td>
<td></td>
<td></td>
<td>3,171</td>
</tr>
</tbody>
</table>

We questioned pilot users about whether they found the Copy Method a reasonable way to transfer correspondence of archival value to the archives. Participants had several reactions:

- Some found it difficult to predict the significance of a message at the time of creation.
- Some worried about third-party privacy and confidentiality issues.
- Some had intentions to do a thorough review of their legacy e-mail for transfer and never found the time.
- Some learned that they transacted much less business of significance over e-mail than they had earlier believed.
- Some felt the system worked exactly as needed.
- None said the system itself was too difficult to manage.

During the course of the pilot, several pilot members upgraded the version of their e-mail programs (Outlook 2007 to Outlook 2010, for example). Each time this occurred, we had to obtain a test copy of the new program, re-test the “copy method,” and generate new training materials and set-up procedures. We then had to return to the desk of the pilot user and re-affiliate the mail accounts so that drag-and-drop was once again possible. This occurred with greater frequency than we had expected.

The Director of the Residential College, coming to the end of his tenure in office, wanted to transfer a large number of messages to the archives through the archival box. His needs pushed the limits of the system to the breaking point. He wished to transfer hundreds of
nested folders, comprising more than a gigabyte of material, much of it stored off-line in a local pst folder. He wanted to be able to drag-and-drop whole folders containing messages and sub-folders (as opposed to individual messages) and have the permissions that allowed the archives access inherit from the parent folder automatically, rather than granularly assign permissions to each folder by hand. While we were able to accommodate his needs, we decided to recommend that he transfer more than half of his accumulated legacy e-mail by creating a PST on an external hard drive which we hand-carried from his office to the Bentley. This proved faster and less frustrating.

One executive did not use the “Copy Method” to transfer messages of intrinsic significance, but did use it for a delivery method for university records. His assistant created several packages of minutes and other archival-quality documents, compressed them into ZIP files, attached them to brief messages, and deposited them in the archival e-mail box. In this way, the archival e-mail box acted as a digital drop box.

6. Lessons Learned from the Pilot

This pilot taught several useful lessons. First, we learned that the changing technological landscape required constant vigilance. Despite its simplicity, our Copy Method required a lot of desktop support and was not very scalable.

Second, and most importantly, we learned that, for a variety of reasons, participants found it difficult to populate the boxes with e-mail. We came to understand that despite the best of intentions, executives would not reliably target messages for the archives on-the-fly. We agreed that any future system would need to capture larger chunks of data (defined by folders or time periods), and require less effort for the executives. This result emphasized what we already knew: we needed better incentives, most significantly, a supporting policy that specified the types of e-mail that should be retained and that highlighted executives’ responsibilities to render them to the university.

Finally, it became very clear to us that though archivists had a clear idea of the kind of e-mail that was of interest, the deans were concerned about the total information flow within their offices. They observed that important e-mail derived from a number of contexts and not simply from their own desktops. These e-mails existed in both individual’s digital workspaces as well as collective digital workspaces. The Bentley team concluded that we would have to move beyond our specific strategy to recover e-mail to a more comprehensive approach to the capture of born digital records.
Phase III – Developing a Plan for Managing Captured E-mail

While messages were accumulating in pilot testers’ archival e-mail accounts, the project’s technical and functional leads and the digital curation archivist embarked on a program of intense discovery and development. We needed to turn to the task of figuring out how we would transfer, process, describe, store and provide access to the captured messages. Phase III, in which the team decided how to manage the acquired correspondence, overlapped in time with Phase II, and indeed, still continues as of June 2013.

Our goal was to move from an institution in which we developed individualized workflows for particular series of electronic records to one in which transfers of electronic records (including e-mail) could be treated as routine, and handled using generic workflows, processes and policies. In this goal, we have largely succeeded.

1. Creation of Workflows and Development Plans

The team understood that the policies, procedures and infrastructure produced by the project would need to comply (or permit later development to achieve compliance with) the Reference Model for an Open Archival Information System (OAIS). The solution would also need to reflect an awareness of the Trusted Repositories Audit and Certification: Criteria and Checklist. In developing the workflow and architecture, the team incorporated the micro-services approach to digital curation. Rather than develop a single tool that accomplishes the various processing or storage functions, this approach involves the implementation of discrete services for specific functions: one application handles checksum validation while another assigns unique identifiers, a third performs format validation, and so forth. Although each service is independent of the others, they are interoperable in that together they accomplish preservation goals.

Greater efficiency can be attained by writing a script to pipe content through successive steps, an approach which has been successfully applied by several digital preservation collaborations, including the National Archives of Australia’s Digital Preservation Software Platform, the California Digital Library, and Artefactual Systems’ Archivematica. This architecture permits the archives to identify key processing functions and then utilize stand-alone applications that correspond to each. When a new version or a different product that serves a given function emerges, the archives simply replace that individual component instead of overhauling the entire system.

---

After experimenting with available tools and techniques, the team convened to map out a desired workflow, and identify policy needs and additional resources required by the archives to fully manage and preserve digital records, including the archival e-mail of the University of Michigan. This early planning is embodied in the “Digital Infrastructure Development Plan” and an early conception of the “UARP Digital Records Workflow” (Appendices 13 and 14, respectively, on pages 76–83). While these documents were very useful to help us plan the work, they do not wholly reflect the workflow as implemented as of the writing of this case study. Creating the plans and diagrams was quite useful to help us visualize the points of contact between different systems and to understand what part of the work could be automated and what part could not. In execution, however, some functions were prioritized over others. For example, in our current system, we do not undertake extensive de-duplication, though we hope to eventually add that functionality.

The UARP Digital Records Workflow diagram indicated the various procedures the captured e-mail (and other digital records) would undergo, from initial appraisal by archivists through deposit in a permanent repository. While the diagram includes negotiations, policy-based decisions, and steps related to arrangement, key technical procedures included:

- Transfer and accession electronic records from record creators
- Digital processing
  - Conduct virus scan
  - Create backup of content
  - Extract attachments (if records are e-mail)
  - Generate checksums
  - Correct illegal filenames
  - Identify and validate formats
  - Extract metadata
- Package records and metadata for long-term preservation
- Deposit package in permanent repository
- Import essential metadata to the Bentley Library’s collections database to facilitate object tracking and management

2. Selection of an Interim Repository

One of the challenges we faced in the development of our digital processing workflow stems from the fact that the Bentley Library is a small unit on campus, and is not part of the large University Library. The Bentley does not employ IT staff, although two archivists on staff share responsibility to provide essential IT services such as troubleshooting, desktop support, software upgrades, and basic database and network maintenance. Considering the financial climate of 2009–2011 and the university’s efforts to consolidate IT services on campus, we knew that any system we developed would most likely have to be sustained by our own current staff.
Prior to this project, the Bentley archivists used their desktop computers as the initial accession location for digital materials and conducted all necessary procedures, such as virus scans, checksums, arrangement and description, locally.

This meant that archival records received on removable media, or transferred by FTP, were downloaded directly to the archivist’s local hard drive. Under the pre-2009 procedure, once the digital records had been processed, arranged and described, they were placed in one of a variety of permanent storage and access locations, which included servers run by the University Library’s Digital Library Production Services, Institutional File System (IFS) servers run by Information Technology Central Services (ITCS), and or optical disks stored on site at the archives.

One of the first important tasks for the development of our digital processing system would be to create a well-managed “Interim Repository” that could serve as the accession and processing location for newly acquired digital materials, and provide storage for our digital records backlog. We needed networked space that would provide secure, backed-up storage for sensitive materials. Bentley archivists needed to be able to manage privileges of processors, including student workers.

After reviewing and testing available options we selected a service provided by the University’s Information and Technology Services, called “Mainstream Storage.” This service provided Common Internet File-System (CIFS)-based space and did not require a systems administrator. The servers are housed in a high-availability enterprise university data center, which is monitored by ITS. It included a “snapshot” capability, which allows end users to restore deleted data without the need for specifically requesting a restore from an ITS staff member. Bentley archivists are able to control the Access Control List (ACL) permissions. The cost of this service was $3.36/GB per year. Our need for digital storage is always increasing in part as a result of the accession of large collections containing media content. As of October 2, 2012, the Interim Repository comprises 3.12 TB and costs nearly $11,000 per year.

3. Selection of a Permanent Repository

In selecting a permanent repository, we desired an environment that possessed at least some attributes of a trusted digital repository. The Mainstream Storage service lacked important features and functionality required to meet professional best practices. Although we reviewed repository packages including Islandora, ICA-AtoM and Fedora, they could not be implemented without additional IT infrastructure and personnel. Therefore we reviewed available options on campus.

Two repositories at the U-M have undergone the TRAC audit process: HathiTrust, which was certified in March 2011, and the Intra-university Consortium for Political and Social

---

Research (ICPSR) data archive, which underwent a test audit in 2006. Neither of these repositories was appropriate for providing storage and access to archival records, because they had each been optimized for the storage of particular kinds of data objects—book-like objects in the case of the HathiTrust, and social science data sets, in the case of ICPSR. Instead we turned to Deep Blue, the U-M’s DSpace-based institutional repository.

Deep Blue had been developed by the University Library in order to provide “permanent, safe, and accessible service for representing our rich intellectual community.” It was designed to allow U-M authors to self-archive their works, however, and not explicitly to archive institutional records. Deep Blue did have policies to allow a variety of digital object types and formats. Though the hierarchies that are so important to archival arrangement are not very well supported by the DSpace technology, we decided that we could clarify the contextual relationship of the individual digital files through external finding aids.

Fortunately, a 2010 memorandum of understanding between Bentley Historical Library Director Francis X. Blouin and University Librarian Paul Courant permitted archival materials to be stored in Deep Blue. In order to properly manage archival material, however, some additional enhancements to Deep Blue needed to be made.

The most difficult issue involved the temporary restriction of executive-level records in the repository. At U-M, though all records are subject to the state’s Freedom of Information Act, records of the university’s Executive Officers, Deans, and Directors and their staffs are restricted for a period of twenty years from the date of their accession. The restriction means that they “are not automatically available for examination by the public.” Under current practice for paper records, the office of origin is able to access restricted records through an archivist, and a member of the public can submit a Freedom of Information Act request for access. Therefore, a requirement for our permanent repository was that access to the archival e-mail records of university leaders would be embargoed to the public (but accessible to archivists) for a period of twenty years. In addition, the Bentley wanted to be able to control what metadata was publicly exposed.

The team began an exploration with the administrator of Deep Blue, James Ottaviani, to determine whether additional features could be developed, and if so, to create them. New functionality would include the following:

- Restricted public access to the metadata and content of sensitive materials (especially e-mail);

---


● Ingest file identification and technical metadata extraction using the Digital Record Object Identification (DROID) software\textsuperscript{10};
● Periodic fixity checks;
● Reports that would track preservation events (such as validation and integrity checks) as well as outages and data loss to archivists;
● A curatorial interface that would permit archivists more direct control over the management of content.

By May 2011, the team was satisfied Deep Blue could be successfully modified to meet our essential requirements. With the Interim Repository in place, and the Final Repository identified, we could begin the additional work of creating the procedures to enact our digital records processing workflow and move archival material securely from one to the other. Though the Bentley plans to develop automated scripts to deposit many kinds of records into Deep Blue, our responsibilities to fulfill the expectations of our funder, the Mellon Foundation, required us to focus on e-mail first. The team secured the services of a developer within the University Library’s Information Technology unit to write the script that acquires the e-mail file from the Bentley’s Interim Repository, performs digital processing micro-services upon it, and deposits it in Deep Blue.

Not all of the modifications to Deep Blue were complete as of June 2013, but we are making progress. Most significantly, the archivist’s curatorial interface and the embargo functionality will be realized to enable us to manage the e-mail of university executives responsibly.

4. Identification of the Preservation Format and the Archival Information Package’s Components

We could not hand off the scripting job to the library’s programmer, however, until we had defined the package that we wanted to preserve in Deep Blue. Before we launched the pilots with the university executives and faculty members, we had made a determination that MBOX would be the preferred storage format. This was important because we needed to know we could promise the pilot users that we could extract and preserve the e-mail messages that they were endeavoring to identify for the archives.

Picking MBOX was not an easy decision, however, because we were not fully satisfied with any of the choices available. We considered PDF, the CERP project’s XML schema, PST, text and tiff formats in addition to MBOX. In the end, we settled on MBOX because it is an open (though sometimes inconsistently interpreted) protocol that enjoys support from the technical community. Practically, this meant that we could use a widely available MBOX viewer, such as Thunderbird, to provide access to the archived records.

\textsuperscript{10} British National Archives, Digital Record Object Identification (DROID), retrieved May 3, 2013, from http://sourceforge.net/projects/droid/. By June 2013, the file identification and validation function had been pushed upstream in the digital processing workflow and will be conducted by Bentley archivists prior to submitting the deposit into Deep Blue.
An MBOX file consists of a concatenated list of the text of e-mail messages, including header information and associated metadata. Attachments are encoded in binary. We decided to preserve the original MBOX files, with the encoded attachments intact, but to augment the package with copies of the attachments. This would allow a search engine to search across the text in the MBOX files (the message bodies and headers), and also the content of the attachments. Extracting the attachment would become one step in the automated processing workflow.

We decided to create one MBOX file for each folder in the e-mail account to be preserved. To accomplish this we developed two protocols, one for e-mail on the IMAP server, and one for Exchange. We accessed the archival accounts on the IMAP server using a plugin for Thunderbird called ImportExportTools. Thunderbird is a program that is often used to help users move e-mail from one account to another because it automatically creates MBOX files on the drive of the person accessing the e-mail account.11 We used a tool for Outlook called MessageSave to create MBOX files for archival e-mail accounts on the Exchange server.12

To provide access to the e-mail, an archivist with appropriate permissions would download the MBOX account from Deep Blue and view it with Thunderbird or another MBOX viewer, such as Mailbag Assistant.13 These tools allow robust searching and sorting across the archived account with user interfaces that would be familiar and easy to use.

In the OAIS Reference Model, the object of preservation is known as the Archival Information Package (AIP) and it is comprised of “Content Information” that is packaged with “Preservation Description Information,” which includes metadata that establishes the provenance, context, fixity, and identity of the package. For this project, the package would consist of an MBOX file, extracted (but unnormalized) attachments, the original PST file, if one existed, and associated descriptive, technical, and structural metadata. The package would be bundled together in a ZIP wrapper. (See Appendix 15–SIP and AIP, page 84). The “Dissemination Information Package” (DIP), would include the packaged MBOX files and the associated metadata (METS XML documents and addition logs.) Because all access to these e-mail accounts is mediated by an archivist, we were not concerned that an end user would be confused by receiving a METS files together with the content. The somewhat awkward access procedure, requiring a download to the desktop and application of a viewer before a search of the content could be accomplished we viewed as a “good enough” process for the expected low demand for access to these records over the period of the twenty year restriction.

After reviewing a wide range of metadata standards and the practices of peer institutions, Michael Shallcross, the project’s technical lead, developed the METS file that would structure the metadata. (See Appendix 16–Sample METS Package for E-Mail, page 85).

---


Creation of the METS XLM document for each accession will be automated, so that output files from various processing tasks are parsed and important elements inserted into a template. Of particular importance are the PREMIS preservation events that will help establish the provenance, integrity and authenticity of the preserved correspondence.

With the completion of the documentation for the SIPs, AIPs and DIPs, the programmer could begin the task of writing a script for digitally processing the packages. This programming is complete, though we await the implementation of the archival interface to Deep Blue to complete its testing.

Though the Bentley has processed several legacy e-mail collections, and the messages acquired as part of our pilots, we are still developing procedures to acquire archival e-mail from Google Mail, our new e-mail system. U-M is just now completing the staged conversion of all students, faculty and staff to Google Mail. When the transition to Google Mail is complete, the Bentley plans to convene with the newly appointed ITS Google product manager to identify tools and procedures that will be applied to acquire archival e-mail now stored in the cloud. In the meantime, we will use the developed workflow to process and deposit any e-mail acquired we acquire on an ad hoc basis. Flexibility and creativity will be once again required in order to craft a solution to preserve the permanent records of the U-M. Fortunately, the Bentley’s staff is now much better armed and organized to be able to attack the electronic records issues it faces today.

5. Organizational Transformation

The challenges of managing born-digital materials inspired the Bentley to conduct a rigorous self-analysis that has led to a restructuring of the library’s organization to better support the development of the policies and procedures for the preservation of born-digital materials. The creation of the new Digital Curation Services division of the Bentley Library is a direct outcome of the activities conducted during this project.

At the commencement of the project, Archivist Nancy Deromedi was the only permanent member of the Bentley’s staff with substantial expertise in managing born-digital materials. Although her position was within the University Archives and Records Program (UARP), the other collecting unit, the Michigan Historical Collections, constantly sought her guidance as new born-digital materials were acquired. Adding project archivists Shallcross and McKay to UARP allowed the work of creating a system to process and describe born-digital materials to progress very quickly, but highlighted an imbalance in the location of expertise for the management of electronic records. It made sense that the same workflows and methods developed within UARP should be re-used to the extent appropriate across the institution, but the governance of the process needed to be rearranged, so that the needs of both divisions could be represented.

Since May 2011, the new Digital Curation Services division has created a manual to guide all Bentley archivists and graduate student processors through the digital

---

14 The Health System and Flint branch campus will not convert to Google Mail but will retain Outlook/Exchange.
processing workflow. The particular tools, methods and metadata structures that enable routinized treatment have been selected, deployed and developed, and in many cases automated scripts have been created to link steps together to eliminate manual processes. In addition, we have modified our collection management system, called BEAL, to track the accession, storage and processing status of digital collections.

Another ancillary benefit from the project was to bolster our efforts to promote a revision of the records policy of the U-M. Results from our pilots, combined with evidence of the dearth of executive correspondence being transferred to the Bentley from many deans’ offices helped persuade university leaders to convene a new Records Management Task Force. Through targeted meetings with the university’s general counsel, auditor, and chief information officer, Bentley Director Francis Blouin was successful in negotiating for resources for a university-wide initiative to revise the records management and retention policies at the university from top to bottom. This initiative is being supported by the leaders of the university and has resulted in a new policy framework, and a business case for a records management program (including a dedicated records manager), and a governance structure that will allow for accountability and enforcement of the policies.

Conclusion

We embarked on this project in 2008 with an intention to solve the e-mail as archives problem. Our first attempt was to identify and acquire commercial off-the-shelf software. The failure of the market to offer very good solutions, economic challenges, strategic changes to the IT infrastructure, and the complexity of the university as an organization led us to withdraw our request for proposals without awarding a contract. Our second strategy tested the proposition that university leaders could be motivated to nominate archival-quality messages in the course of their daily work. It was also largely unsuccessful. But though we may have lost two battles, we may have won the war, because the injection of targeted resources and effort has boosted the Bentley to complete the daunting work of building a digital records workflow. Through the generosity of the Mellon Foundation, we may not have solved the e-mail problem, but we have been able to take enormous strides in thinking through and building a digital archives program that can scale to an institution the size of U-M.

---


Testing checklist

Aprille McKay
March 1, 2010

Evaluator: deromedi
Role: Dean
Email client: Mac Mail

Test protocol:
1. Describe whether you had to do anything to make the archival box appear in your client

Yes. The USER box appeared in Mac Mail however, it was grayed out and unusable. To activate the account, I learned that I needed to subscribe to the account. Here is how you subscribe to an email box in Mac Mail:

a. Go to the User folder
b. Click the curly arrow on the right side of the User folder
c. Clicking the arrow will bring up a dialog box
d. Click on the User folder and the archive folder bhl-unique will appear underneath as seen in the next screenshot.

![Account Info](image)

- Users
  - bhl-deromedi

- Subscribe
- Unsubscribe

2. Capture screenshot of how the archival box appears in your client

![Screenshot](image)

Here is the screen shot of the bhl-deromedi box which is located within the list of all folders on the left hand side of the screen.

e. Click the small box to the left of bhl-unique.
f. Click subscribe located at the bottom of the screen.
Feedback on how this looks: The User folder is lighter in color than the bhl-deromedi folder.

3. Move an existing message from inbox into archival box
   a. Describe how it is done (drag and drop, pulldown list, etc)

In Mac Mail, you can either drag and drop the message from any folder including the INBOX to the bhl-
uniqueuname folder or use the MENU tabs to copy or move a message to the archived mailbox.

In the drag and drop option, you can also **copy a message** to the bhl-uniqueuname folder by holding
down the option key as you drag the message to the folder.

The second option is to move or copy the message using the menu commands.

   1. Select message
   2. Go to menu MESSAGES
   3. Select message and then from the pull down menu select COPY TO or MOVE TO and the list of
      folders appears to the right > of the arrow.

   b. Feedback on this functionality: Easy to use.

4. Copy an existing message from inbox into archival box (leaving the original behind)
   a. Describe how this works in your individual client (holding down a function key while
dragging, etc.)
   b. Feedback on this functionality: Very easy to use.

5. Move an old sent message into archival box
   Done, drag and drop

6. Copy an old sent message into archival box
   Done, drag and drop using the Option key to make a copy.

7. Move several old received messages into the archival box at once
   a. Describe how it is done

   I highlighted the first message to archive and then used the SHIFT key to select more than one
   message. I then drag and dropped the group of 13 into the bhl-deromedi folder.

8. Copy several old sent messages into the archival box at once

Done, selected messages and then dragged into archive folder.

9. Move an entire folder into the archival box (you can create a dummy one with a few messages
   first)
a. Can you do this? No. I need to open the folder and then select the messages within the folder and drag/drop to archived folder.
b. Describe how it works—It does not work in Mac Mail to drag a folder. However, I can create a target folder within bhl-deromedi and then drag all of the messages from the folder I want to archive into the new folder.

10. Copy an entire folder into the archival box (leaving the original behind)
    a. Can you do this? Yes,
    b. Describe how it works. Create a target folder within bhl-deromedi and then drag all of the messages from the folder that you want archived. The drag can be move or copy of messages.

11. While you are sending a message, add the archival box as an addressee on the cc: line. Do this for three messages.
    a. Did it work or did you get an error message? This did not work and here is the error message I received:
b. What are the subject lines of these messages?  
n/a  All messages failed to be delivered.

12. While you are sending a message, add the archival box as an addressee on the bcc: line. Do this for three messages.
   a. Did it work or did you get an error message?
   b. What are the subject lines of these messages?

Error message for CC, FWD, and BCC

13. Select three old message in your inbox and forward them to the inbox
   a. Did it work or did you get an error message?
   b. What are the subject lines of these messages?

The same error message for cc, fwd and bcc

14. Deposit messages in the archival box (using whichever technique) that contain the following types of attachments:  pdf, Word, Excel, PowerPoint, jpeg, gif.
Done.

15. Create a folder within your archival box labeled “sent-mail” transfer some (but not all) sent mail messages into it

Done,
1. Highlight User bhl-deromedi
2. Go to menu MAILBOX
3. Select from pull down New Mailbox
4. Dialog box appears and asks what you would like to call new mailbox within bhl-deromedi
5. Name box

Here is the new sent-mail folder within bhl-deromedi

16. Assuming that several of our pilot users sometimes access their mail via webmail, open your webmail account.
   a. Capture a screenshot of how the archival box presents in webmail

Web Mail BLUE Screenshot:
b. Assess how the switch to a different interface affects your experience. Was it confusing? Did it work as you expected it to work?

It was not confusing to switch from MAC Mail to Web Mail Maize. These two interfaces are very much the same drag and drop GUI. The main difference is that in Maize you cannot copy messages, just move messages. Going from Mac Mail to Web Mail Blue—it is a different interface because access to folders is not along the side of the interface but, you need to select the Folders tab that runs across the top of the screen to access your folders. Unlike, webMail Maize, you can copy and move messages within Web mail Blue.

c. Within webmail, can you put a message in the archival box?  
   YES

d. Can you access the archival folder and delete something out of it? YES

17. Go into your archival box and delete messages
   a. Describe how that works.
      In webmail Blue-check box and delete.
      In Mac Mail, highlight message and delete.

18. As an administrator, forward three messages to Aprille to file in your archival box. DONE

19. As an administrator, message Aprille to delete messages on a particular topic from your archival box. DONE

20. Can your email application set up a “rule” so that every email you send is automatically cc’ed or bcc’ed to the archival box? Describe how this works.
    Yes, Go to menu under MAIL
    Select Preferences
Select Rules
Set up rule to capture all messages from (person’s name)
Select option for move or copy messages to bhl-unique

21. How many messages can be transferred at once?
   a. Can you get it to choke? Try moving 200 messages at once, if that works, try moving more. I moved 800 messages into the box without a problem.

   b. Does there seem to be a limit? It is hard to tell.
   c. Can you identify whether the limit is the number of messages or the size of the volume moved?

22. [Not appropriate for IMAP clients, but for Outlook/Exchange – how does delegation of access privileges work? Capture screenshots of the process to delegate delete rights to a secretary.]
Testing checklist: Copy Method Outlook 2007

Aprille McKay
June 7, 2010

Evaluator: Aprille McKay

Role: Initially record creator, but after experimentation, archivist with Daphne as record creator.

Email client: Outlook 2007 on a PC

Test protocol:
1. Describe whether you had to do anything to make the archival box appear in your client
   a. If yes, capture screenshots of the process
      Tools menu
      Account settings
      Change
      More Settings
      Advanced
      Add “bhl-aprille”
      Save
      Close Outlook and open it again and see if the mailbox appears
      [Or, instead of “Save” click “Apply” and then you don’t need to close Outlook]
2. Capture screenshot of how the archival box appears in your client
This is how it appears in Aprille’s client. Aprille delegated mailbox access to Daphne and this is the way it appears to Daphne.
The two folders, MeMail Main Folder and MeMail test are folders that Daphne dragged and dropped into the mailbox. Both Aprille and Daphne have access to these folders. This indicates that the way to deploy this solution would be to have the box be created for the archivist, and have the archivist delegate access to the record-creator. This makes for a much cleaner appearance for the record creator, without all of the additional folder apparatus.

a. Feedback on how this looks:
I don’t like how complicated this appears to be in Aprille’s mailbox. Instead of one folder “bhl-aprille” there are 14 items that are automatically generated as part of an Outlook mailbox. Is there a way to make it be just one box – an inbox? Or to allow only folders that the end user creates? This entity doesn’t need a calendar or drafts. Perhaps a spam box is a necessity, but that’s the only one. [Update: Aaron responded to Daphne that it is probably not possible to skinny down the list, but reversing the delegation does seem to be a good work-around.]
3. **Move** an existing message from inbox into archival box
   a. Describe how it is done (drag and drop, pulldown list, etc)
      • Drag and drop
        o Can move multiple messages at once:
          ▪ To select adjacent messages, click the first message, and then hold down SHIFT and click the last message. All messages in the list between the first and last message you clicked are selected.
          ▪ To select nonadjacent messages, click the first message, and then hold down CTRL and click additional items
      • You can also move by using menu commands:
        o Select the item you want to move
        o On the Edit menu, click **Move to folder** [or CNTL+Shift+V]
        o In the **Move Items** dialog box, click the folder where you want a copy of the message saved, then click **OK**.
        o The bhl-uniqname box may need to be expanded. Click on the + next to the folder name and then drop the message in the Inbox.
        o After you have moved one message, you can repeat moving to the same folder easily by highlighting the message, and hitting CNTL+Shift+V and then Enter, to confirm.
      • You can also move by using the clipboard:
        o Select the item you want to move
        o On the **Edit** menu, click **Cut** [or CNTL +X]
        o Navigate to the folder where you want to save the copy and then on the **Edit** menu, click **Paste**. [or CNTL+V]
        o The bhl-uniqname box may need to be expanded. Click on the + next to the folder name and then drop the message in the Inbox.
   b. Feedback on this functionality: Pretty easy. Drag and drop aiming might be a little hard for some people depending on dexterity. The folder titles on my computer are in pretty small font (that may just be my resolution.)

4. **Copy** an existing message from inbox into archival box (leaving the original behind)
   a. Describe how this works in your individual client (holding down a function key while dragging, etc.)
      There are three ways to do this, via drag and drop.
      • Hold down “CNTL” while dragging and dropping moves a copy from the Inbox.

      Note, the Help pages for doing this say that when you drag and drop a message, a copy is moved, and not the original, but that contradicts what actually happens when you file messages out of your Inbox. Perhaps the Inbox has different functionality. The Help on this topic does not indicate you should hold down CNTL, but rather, simply drag and drop. Here’s what the “Tip” says:

      “When you copy a message, the message remains in the original folder and a duplicate is saved in the destination folder. If you want to move the message to
the destination folder and delete the message from the original folder, see Move an item to another folder. “But then the link doesn’t work"

- You can also copy by using menu commands:
  Select the item you want to move
  On the Edit menu, click Copy to folder
  In the Copy Items dialog box, click the folder where you want a copy of the message saved, then click OK.

- You can also copy by using the clipboard
  Select the item you want to move
  On the Edit menu, click Copy [or CNTL +C]
  Navigate to the folder where you want to save the copy and then on the Edit menu, click Paste. [or CNTL+V]

  b. Feedback on this functionality:
     Same as for moving. Aiming for drag and drop. Key combinations somewhat hard to remember.

5. Move an old sent message into archival box:
   Worked fine

6. Copy an old sent message into archival box
   Worked fine.

7. Move several old received messages into the archival box at once
   a. Describe how it is done
      See, answer to number 3a.

8. Copy several old sent messages into the archival box at once
   Worked fine using the menu commands

9. Move an entire folder into the archival box (you can create a dummy one with a few messages first)
   a. Can you do this? Yes.
   b. Describe how it works

      Got a dialog box “moving folders from “Folder name” to “Inbox” It took about 20 seconds to accomplish the move. The folder that I moved contained seven messages at the top level, and two sub-folders. One sub-folder contained 19 messages, the other 23, all with attachments.

      [Note this is functionality not present in IMAP testing.]

10. Copy an entire folder into the archival box (leaving the original behind)
    a. Can you do this? No.
    b. Describe how it works
I held down CNTL while dragging and dropping the folder. Under my mouse pointer, a small icon appeared that looked like I was dragging a stack of messages. When I released the mouse button over the target mailbox, however, a dialog box appeared that said “Cannot copy the items. Cannot copy this folder because it may contain private items.”

This is odd that it will allow you to move entire folders of messages, but not to copy them. I wonder why there’s this limitation?

11. While you are sending a message, add the archival box as an addressee on the cc: line. Do this for three messages.
   a. Did it work or did you get an error message?
      In order to send a message to this mailbox directly, right out of the box, the address is: 
      bhl-aprille@adsroot.itcs.umich.edu
      This is cumbersome. There are two solutions to this problem. Either we can set up a nickname in the address book of the user (as we have been doing with the IMAP mailboxes), or we can set up a maillist in the UMODS directory, to direct mail addressed to bhl-aprille@umich.edu to this address.

      To do this:
      Go to the UM directory, and “Bind” by Kerberos authentication
      Click Add
      Enter the name of the group, so “bhl-aprille”
      Under “University Members” check your name to remove yourself from the list (so as not to receive a copy of everything sent to the box in your own personal inbox).
      Add the archival box’s address, following the convention: bhl-aprille@adsroot.itcs.umich.edu
      [Note, need to confirm that all of our email boxes will be set up on this same server, and all addresses will follow this convention]

   b. What are the subject lines of these messages?
      N/A

12. While you are sending a message, add the archival box as an addressee on the bcc: line. Do this for three messages.
   a. Did it work or did you get an error message?
      It worked when I addressed bhl-aprille@umich.edu (the mailing list, from a Gmail account), but it didn’t work when I addressed bhl-aprille@adsroot.itcs.umich.edu (the direct box address, also from a Gmail account. Note that though I addressed the message to myself at aprille@umich.edu, with a blind copy to the archival box, I did not receive either copy.)
   b. What are the subject lines of these messages?
      N/A

13. Select three old message in your inbox and forward them to the inbox
   a. Did it work or did you get an error message?
I forwarded to bhl-aprille@umich.edu and it worked. When I began typing “B” it suggested the address to me. It also worked from within Outlook when I addressed it to bhl-aprille@adsroot.itcs.umich.edu.

b. What are the subject lines of these messages?
Messages addressed to bhl-aprille@adsroot.itcs.umich.edu that did not arrive had the word “wikileaks” in the subject line.

14. Deposit messages in the archival box (using whichever technique) that contain the following types of attachments: pdf, Word, Excel, PowerPoint, jpeg, gif.

Done

15. Create a folder within your archival box labeled “sent-mail” transfer some sent mail messages into it.
   a. Describe the process of folder creation:
      Note that in the automatic build for these boxes, there is already a folder called “Sent Items” This is not within the Inbox, but rather is at the same level as the Inbox.

      Creating a new folder is easy:
      Highlight the folder that you want to make a subfolder in. Right click, highlight New folder, type the name of the new folder in the dialog box and click OK.

16. Assuming that several of our pilot users sometimes access their mail via webmail, open your webmail account. (For Outlook, this is Outlook web access: exchange.umich.edu)
   a. Capture a screenshot of how the archival box presents in webmail

   It doesn’t appear. There don’t seem to be any controls to configure its appearance. This is somewhat problematic, as drag and drop functionality will not be available from the web client. However, it would still be possible to forward and cc.
b. Assess how the switch to a different interface affects your experience. Was it confusing? Did it work as you expected it to work? 
  Didn’t work

c. Within webmail, can you put a message in the archival box?
  No

d. Can you access the archival folder and delete something out of it?
  No

17. Go into your archival box and delete messages
   a. Describe how that works:
      Can highlight a message to delete and
      • click the “X” at the ribbon on the top of the screen, or,
      • right click and select the “X” on the mouse menu, or
      • “CNTL+D” or
      • go to the **Edit** menu and scroll down to “Delete”

18. Forward three messages to Aprille to file in your archival box.
    Aprille forwarded a message to Daphne to file, but as it turned out, rather than being the administrator, Aprille’s mailbox would be that of the archivist, and Daphne’s that of the administrator.

19. As an administrator, message Aprille to delete messages on a particular topic from your archival box.
    Didn’t do, but confident that it would work.

20. Can your email application set up a “rule” so that every email you send is automatically cc’ed or bcc’ed to the archival box? Describe how this works.
    Tools
    Rules and alerts
    New rule
    Start from a blank rule
    Check messages after sending
    Next
    Don’t select any of the checkboxes
    A dialog box appears “this rule will be applied to every message you send. Is this correct?”
    Yes
    Check “move a copy to the specified folder”
    In the lower box, click on the word “specified”
    Highlight “Mailbox – bhl-uniqname”
    OK
    Finish
    A dialog box appears “This rule is a client-only rule, and will process only when Outlook is running.”
    OK
    A checkbox appears on a rule designated “on this machine only”

    ACM tested this and it worked.
21. How many messages can be transferred at once?
   a. Can you get it to choke?
      I couldn’t
   b. Does there seem to be a limit? No.
   c. Can you identify whether the limit is the number of messages or the size of the volume moved?

22. For Outlook/Exchange – how does delegation of access privileges work? Capture screenshots of the process to delegate delete rights to a secretary.
   • Highlight the name of the archival mailbox
   • Right click
   • Properties for mailbox bhl-aprille
   • Permissions
   • Add
   • Search for users, last name first
   • Add
   • OK
   • This person’s name will appear on a list of people with permission. With that person’s name highlighted, click the down arrow drop-down list next to “Permission level” and select “Publishing Editor”

Do not check “Owner” as this is the person who has the power to give others permissions. We don’t want to give away that power.

Note that this process does not give permissions for subfolders. This is a GOOD thing, because it allows us to give access to the mailbox without giving access to all of the extra folder apparatus.

This is from Microsoft Outlook help:
<table>
<thead>
<tr>
<th>WITH THIS PERMISSION LEVEL (OR ROLE)</th>
<th>YOU CAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Create, read, modify, and delete all items and files, and create subfolders. As the folder owner, you can change the permission levels others have for the folder. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>Publishing Editor</td>
<td>Create, read, modify, and delete all items and files, and create subfolders. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>Editor</td>
<td>Create, read, modify, and delete all items and files.</td>
</tr>
<tr>
<td>Publishing Author</td>
<td>Create and read items and files, create subfolders, and modify and delete items and files you create. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>Author</td>
<td>Create and read items and files, and modify and delete items and files you create.</td>
</tr>
<tr>
<td>Contributor</td>
<td>Create items and files only. The contents of the folder do not appear. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Read items and files only.</td>
</tr>
<tr>
<td>Custom</td>
<td>Perform activities defined by the folder owner. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>None</td>
<td>You have no permission. You can't open the folder.</td>
</tr>
</tbody>
</table>

For more information:
http://www.howto-outlook.com/howto/permissions.htm
MeMail Training: Entourage

Last updated 7/20/10 Entourage 2008 for Mac 12.2.5

1. Logon to your email box
2. To add the MeMail archival box to your Entourage mailbox:
   a. From the top menu, select “Entourage,” and then “Account Settings”

   ![Entourage Menu]

   b. A box will appear with your account listed. Highlight the account and double click

   ![Accounts Menu]

   c. Choose “Delegate” from the menu at the top of the dialogue box

   ![Edit Account]

   d. Under the category, “Users I am a delegate for” click “Add”

   ![Add Delegate]

   e. Type the name of your box in the blank, using the convention “bhl-uniqname” and then click “Find.” When it finds your mailbox, click on it to highlight it, and click OK.
f. Click “OK” again. [You may need to enter your Active Directory password again to confirm the change to your account.]
g. The MeMail archival box will appear at the bottom of your folder list in your mailbox.
3. Create a new message and cc: the archives box by typing bhl-
uniqname@umich.edu on the cc line

4. Filing Exercises:
   a. Move a message you have received into the archives box. (Drag and
      Drop). It may take a few seconds for the system to synch and the
      message to appear in the archival box
   b. Copy a message from your INBOX to the Archives Box.
      i. Select message and hold down the Option key. Drag the
         message to the Archives box.
      ii. You can also highlight the message, and then choose “Duplicate
          Message” from the “File” menu. It will create a copy of the
          message in the same folder, which you can then drag and drop
          to the archival MeMail box.
   c. Set a filter to have all mail from Executive Committee to be cc’d
      automatically to your archives box. For this example, we will tell
      Entourage to file a copy of every message addressed to
      “executivecommittee@umich.edu” in the MeMail box called bhl-
aprille@umich.edu
      • Go to Menu: TOOLS > Mail (Exchange) > Click the “New” icon.
      • In the blank, give your rule a name, eg. “Executive Committee”
      • Click “Add criterion”
      • Click on “All messages” to bring up a pull down menu, and click on
        “Any recipient”, “contains” and then enter the address of the
        mailing list for the executive committee.

      • Now tell Entourage what action to take on these messages. Click
        “Add action.” Select “Copy message” and then the MeMail archival
        box from drop-down list of your folders.
      • Click OK and exit.

5. Create a new subfolder within the archival box.
• Click on either the root mailbox “BHL-uniqname” or the Inbox within this box, whichever you prefer, and right-click (or click while holding down “control”) to bring up a menu.
• Select “Create new folder”
• Name your new folder, and make sure that it is placed correctly in the hierarchy. Click “OK”
• By default, the access privileges from the parent folder are automatically inherited for the new folder that you have created, except that you are a co-owner of the folder (with the archivist), and have the ability to modify permissions for this folder from the default settings.
• To modify permissions for your newly created folder:
  o n.b. This technique only allows you to set permissions for someone with at least view privileges for the parent folder. To add a brand new user to the archival box, please contact Bentley Archivist Aprille McKay (aprille@umich.edu).
  o Click the “Send Receive” button on the upper ribbon to make sure that your new folder is synched with the Exchange server.
  o Right (or CNTL) click on the new folder you have created, and click on “Sharing.”
    o Highlight the user you wish to change access privileges for, and check (or uncheck) the appropriate boxes.
6. Copy a group of messages from your INBOX to archives box.
   • Highlight group of messages by holding down the shift key.
   • Drag and drop while holding down the option key.

7. MeMail archival box and Outlook Web Access.
   • Unfortunately, it is not possible to drag and drop messages from your regular Mailbox to the archival mailbox (bhl-uniqname) using Outlook Web Access. You can transfer a copy of a message to the archival box from within Outlook Web Access by forwarding, cc’ing, or bcc’ing the message.
   • If you use Outlook Web Access with Internet Explorer (but not Firefox or Safari), you will be able to simultaneously view both mailboxes in different browser windows at the same time – perhaps to determine whether a particular message has been saved to the archival box. To do this, after you log on to Outlook Web Access (exchange.umich.edu), click on the down arrow next to your name in the upper right hand corner.

   ![Screenshot of Mailbox Selection]

   • In the “Select mailbox” area, enter the name of your mailbox, using the following formula: bhl-uniqname@adsroot.itcs.umich.edu, where the uniqname is replaced with the name of your box. Click “open” and another browser window will appear with access to the contents of the archival box. After you have created this the first time, the Outlook Web Access will remember and will suggest it when you start to type bhl.
MeMail Training: Mac Mail

Last updated 6/1/10 MacMail version 3.6 (Nancy) 4.2 (Aprille)

1. Logon to your email box
2. Locate the archival email box in the list of your folders.

Note that you may have to “subscribe” to make the box appear. If there is a “curly arrow” next to the word “Users”, click it.

A dialogue box will appear. Click on “Subscription List” and the right-pointing triangle next to “Users”. Check the box next to your archival box, and click the “Subscribe” button.
Another way to get to the dialogue box that will let you subscribe, is to highlight "Users" in the list of folders, and then click the gear icon at the bottom of the folder list.

Click on “Get Account Info” and follow the same steps outlined above when the "Account Info" dialogue box appears.

3. Add a shortcut name for the address in your MacMail address book:
   a. Go to MAIL > Preferences > Click on tab called Composing
   b. Click box under Addressing for: Automatically complete address
   c. Compose test message and cc archives box.
   d. With cursor over the archives box email address, click the arrow on the right of the box ADD to Address Book
   e. Name your archive box (e.g. File, Archives, Record, File to Archive)
   f. Test the address box short cut by creating a new message and cc: archives box by typing ______________________

4. Create a new message and cc: the archives box by typing ___________ on the cc line.
5. Filing Exercises:
   a. Move a message you have received into the archives box. (Drag and Drop)
   b. Copy a message from your INBOX to the Archives Box.
      i. Select message and hold down the Option key. Drag the message to the Archives box.
      ii. You can also COPY or MOVE a message by going to the menu Message > and select Copy or Move a message. Your archives folder will be present in the list of folders.
   c. Set a filter to have all mail from Executive Committee to be cc'd automatically to your archives box.
      • Go to Menu: MAIL > Select Preferences
      • Select Rules (tab)
      • Add rule
      • Add description e.g. executive committee
      • Set filter e.g. all message from execomm@umich.edu file to archives box bhl-user@mail.umich.edu

4. Move a group of messages from your INBOX to archives box.
   • Highlight group of messages by holding down the shift key.
   • Drag and drop messages to archives box.
   • Or, if you would like to place a copy of the message then while dragging and dropping hold down the option key.
MeMail Training: Mulberry

1) Logon to your email box
2) Locate the archival email box in the list of your folders

3) Add a shortcut name for the address in the Mulberry address book:
   a. Click the Contacts tab
   b. Open the address book you want to use
c. Click “single” to add a new entry

d. Enter “file” in the “full name” blank and the address of the archival mailbox (e.g. bhl-aprille@mail.umich.edu) in the “email” blank. Click “OK” to add the entry to the mailbox.

4) Create a new message and cc: the archival box by typing “file” on the cc: line.
5) File a copy of a message you have received into the archival box
   a. Select the message, and hold “CTRL+ALT” as you drag and drop the message into the archival mailbox.
   b. Alternately, you could set a rule so that if you flag something for the “file” it will automatically copy it to your archival box.

6) Now look at the contents of your box. You can retrieve and use any message that exists in this box as you would any message in any folder, and you can choose to delete a message that exists there whenever you wish.

7) If you use folders to manage your mail, you may know that one entire folder would be important to transfer to the archives. You can’t copy entire folders into your email box per se, but you can create a new folder in your email box, and copy or move the contents of that folder into it. You can do this by selecting all messages in a folder and dragging and dropping (to copy simultaneously, hold “CTRL+ALT”).
MeMail Training: Outlook 2007

Last updated 7/20/10 Outlook 2007 (SP2) to Exchange 2007

1. Logon to your email box
2. To add the MeMail archival box to your Outlook mailbox:
   a. Tools menu -> Account settings

   "E-mail" tab
   Highlight your account
   Click “Change”
Click “More Settings” and then the “Advanced” tab

Microsoft Exchange Settings
You can enter the required information to connect to Microsoft Exchange.

Click “Add”
Type the name of the box: “bhl-xxxxx” and Click OK
Save
Close Outlook and open it again and see if the mailbox appears

3. [Or, instead of “Save” click “Apply” and then you don’t need to close Outlook]
4. Create a new message and cc: the archives box by typing bhl-xxxxx@umich.edu on the cc line

5. Filing Exercises:
   a. Move a message you have received into the archives box. (Drag and Drop). It may take a few seconds for the system to synch and the message to appear in the archival box

   b. Copy a message from your INBOX to the Archives Box.
      
      i. Select message and hold down the CNTL key. Drag the message to the Archives box. The original message should still be there in your Inbox, but you have made a copy in the new folder.

      ii. You can also highlight the message, and then choose “Duplicate Message” from the “File” menu. It will create a copy of the message in the same folder, which you can then drag and drop to the archival MeMail box.

      iii. You can also copy by using menu commands:
           Select the item you want to move
           On the Edit menu, click Copy to folder
           In the Copy Items dialog box, click the folder where you want a copy of the message saved, then click OK

      iv. You can also copy by using the clipboard
Select the item you want to move
On the Edit menu, click Copy [or CNTL +C]
Navigate to the folder where you want to save the copy and then on the Edit menu, click Paste. [or CNTL+V]

(c.) Set a filter to have all mail from Executive Committee to be cc’d automatically to your archives box. For this example, we will tell Outlook to file a *copy* of every message addressed to "executivecommittee@umich.edu" in the MeMail box called bhl-deana@umich.edu

  • Go to Menu: TOOLS > Rules and alerts > Click the “New Rule” icon.
  • Under “Start from a blank rule” click “Check messages when they arrive.”
  • Check “From people or distribution list”
  • In the bottom half of the box, click on the link “people or distribution list” and fill in the email address of the distribution list, and then “Next”

<table>
<thead>
<tr>
<th>Step 2: Edit the rule description (click an underlined value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply this rule after the message arrives</td>
</tr>
<tr>
<td>from people or distribution list</td>
</tr>
</tbody>
</table>

  • Click “move a copy to the specified folder”
  • Click on the text under “specified” and navigate to the archival box.
Click “OK”

6. Create a new subfolder within the archival box.
   - Click on either the root mailbox “Mailbox - BHL-uniqname” or the Inbox within this box, whichever you prefer, and right-click (or click while holding down “control”) to bring up a menu.
   - Select “New Folder”
   - Name your new folder, and make sure that it is placed correctly in the hierarchy. Click “OK”
   - By default, the access privileges from the parent folder are automatically inherited for the new folder that you have created, except that you are a co-owner of the folder (with the archivist), and
have the ability to modify permissions for this folder from the default settings.

- To modify permissions for your newly created folder:
  - n.b. This technique only allows you to set permissions for someone with at least view privileges for the parent folder. To add a brand new user to the archival box, please contact Bentley Archivist Aprille McKay (aprille@umich.edu).
  - Right (or CNTL) click on the new folder you have created, and click on “Properties
    - Click the “Permissions” tab, and highlight the user whose permissions you wish to alter. Check or uncheck the boxes next to the access privileges as appropriate. This setting allows the messages to be viewed, but not refoldered or deleted.

7. Copy a group of messages from your INBOX to archives box.
   - Highlight group of messages by holding down the shift key.
   - Drag and drop while holding down the option key.
8. MeMail archival box and Outlook Web Access.

- Unfortunately, it is not possible to drag and drop messages from your regular Mailbox to the archival mailbox (bhl-uniqname) using Outlook Web Access. You can transfer a copy of a message to the archival box from within Outlook Web Access by forwarding, cc’ing, or bcc’ing the message.

- If you use Outlook Web Access with Internet Explorer (but not Firefox or Safari), you will be able to simultaneously view both mailboxes in different browser windows at the same time – perhaps to determine whether a particular message has been saved to the archival box. To do this, after you log on to Outlook Web Access (exchange.umich.edu), click on the down arrow next to your name in the upper right hand corner.

- In the “Select mailbox” area, enter the name of your mailbox, using the following formula: bhl-uniqname@adsroot.itcs.umich.edu, where the uniqname is replaced with the name of your box. Click “open” and another browser window will appear with access to the contents of the archival box. After you have created this the first time, the Outlook Web Access will remember and will suggest it when you start to type bhl.
MeMail Training: Outlook 2010

Last updated 10/13/13 Outlook 2010 (V 14.0) to Exchange 2007

1. Logon to your email box
2. To add the MeMail archival box to your Outlook mailbox:

   If the user has already been setup in a previous version of Outlook, no additional setup should be required on installation of Outlook 2010. For new users, follow the following procedures:

   a. Click on the “File” and the “Info” tab to bring up the link to “Account information.” Click on “Account settings.”

   Click on “Account settings” again
   “E-mail” tab
   Highlight your account
   Click “Change”

   Click “More Settings” and then the “Advanced” tab
Click "Add"
Type the name of the box: “bhl-xxxxx” and Click OK
Save
Close Outlook and open it again and see if the mailbox appears [Or, instead of “Save” click “Apply” and then you don’t need to close Outlook]
3. Create a new message and cc: the archives box by typing bhl-
xxxxx@umich.edu on the cc line

4. Create a button within Outlook to automatically file your important
messages in the MeMail box. When you are finished, it will look like this:
a. To create the button, click on "Create New" in the "Quick Steps" area of the ribbon.

b. Name the button "MeMail."

c. In the pull-down menu under “Choose an action,” select “Copy to folder” and then choose the Inbox folder under the bhl-uniqname account.

d. Add another action – “Categorize message” and pick a color (say, blue) that would flag for you that the message has been archived.

e. You can also assign a shortcut key to this task, such as Cntl+Shift+1 and add an explanatory text in the “Tooltip text” such as “Copy to bhl-aprille Inbox”

f. Back in your mailbox, click on the “Categorize” button

g. Then choose, “All Categories” from the drop down list. This will allow you to rename “Blue Category” to “Copied to MeMail.” Click OK.

h. Now when you click on the MeMail button, a small color block will appear next to your message that lets you know its already been archived. You can highlight several messages at once and move copies of all of them to the MeMail box.

5. Alternately, you can drag and drop messages into the MeMail archives box

a. Move a message you have received into the archives box. (Drag and Drop). It may take a few seconds for the system to synch and the message to appear in the archival box.

b. Copy a message from your INBOX to the Archives Box.

   i. Select message and hold down the CNTL key. Drag the message to the Archives box ( ). A pop up will ask you if you wish to move or copy the message. Pick “copy.” The original message should still be there in your Inbox, but you have made a copy in the new folder.

   ii. You can also copy by using menu commands:
   Select the item you want to copy to the MeMail folder
   On the Ribbon, click “Move” and then pick "Copy to Folder" from the dropdown.
A file list will pop up. Select Mailbox - bhl-xxxxxxx – Inbox (or other desired folder) from the list.

c. Set a filter to have all mail from Executive Committee to be cc’d automatically to your archives box. For this example, we will tell Outlook to file a copy of every message addressed to “executivecommittee@umich.edu” in the MeMail box called bhl-dean-al@umich.edu

• Go to the “File” tab at the top of the page, select the category “Info” from the left hand menu and select the bottom button: “Manage tools and alerts.”
• On the “Email rules” tab, click the “New Rule” icon.
• Under “Start from a blank rule” click “Check messages when they arrive.”
• Check “From people or distribution list”
• In the bottom half of the box, click on the link “people or distribution list” and fill in the email address of the distribution list, and then “Next”

Step 2: Edit the rule description (click an underlined value)

Apply this rule after the message arrives from [people or distribution list]

• Click “move a copy to the specified folder”
• Click on the text under “specified” and navigate to the archival box.
Click “OK”

Step 2: Edit the rule description (click an underlined value)

Apply this rule after the message arrives
from executivecommittee@umich.edu
and on this machine only
move a copy to the [Mailbox - bhl Dean] folder

- Click, Next and Next again and then Finish.

6. Create a new subfolder within the archival box.
   - Click on either the root mailbox “Mailbox - BHL-uniqname” or the Inbox within this box, whichever you prefer, and right-click (or click while holding down “control”) to bring up a menu.
   - Select “New Folder”
   - Name your new folder, and make sure that it is placed correctly in the hierarchy. Click “OK”
   - By default, the access privileges from the parent folder are automatically inherited for the new folder that you have created, except that you are a co-owner of the folder (with the archivist), and
have the ability to modify permissions for this folder from the default settings.

- To modify permissions for your newly created folder:
  - n.b. This technique only allows you to set permissions for someone with at least view privileges for the parent folder. To add a brand new user to the archival box, please contact Bentley Archivist Aprille McKay (aprille@umich.edu).
  - Right (or CNTL) click on the new folder you have created, and click on “Properties”
  - Click the “Permissions” tab, and highlight the user whose permissions you wish to alter. Check or uncheck the boxes next to the access privileges as appropriate. This setting allows the messages to be viewed, but not refoldered or deleted.

7. Copy a group of messages from your INBOX to archives box. (This will also work from your “Sent Mail” folder.
   - Highlight group of messages by holding down the shift key.
   - Push the MeMail button.
8. MeMail archival box and Outlook Web Access.
   • Unfortunately, it is not possible to drag and drop messages from your regular Mailbox to the archival mailbox (bhl-uniqname) using Outlook Web Access. You can transfer a copy of a message to the archival box from within Outlook Web Access by forwarding, cc’ing, or bcc’ing the message.
   • If you use Outlook Web Access with Internet Explorer (but not Firefox or Safari), you will be able to simultaneously view both mailboxes in different browser windows at the same time – perhaps to determine whether a particular message has been saved to the archival box. To do this, after you log on to Outlook Web Access (exchange.umich.edu), click on the down arrow next to your name in the upper right hand corner.

   ![Outlook Web Access Screenshot](image.png)

   • In the “Select mailbox” area, enter the name of your mailbox, using the following formula: bhl-uniqname@adsroot.itcs.umich.edu, where the uniqname is replaced with the name of your box. Click “open” and another browser window will appear with access to the contents of the archival box. After you have created this the first time, the Outlook Web Access will remember and will suggest it when you start to type bhl.
MeMail Training: Outlook 2011 for Mac

Last updated 9/21/10 Outlook 2011 for Mac (Beta 6) to Exchange 2007

1. Logon to your email box
2. To add the MeMail archival box to your Outlook mailbox:
   a. “Tools” menu -> Accounts
      “Advanced”
      “Delegates”
      Below the box, People I am a delegate for, click the “+” button.
      Search for the assigned box, in the form “bhl-uniname” (BHL stands for Bentley Historical Library.)
      Highlight the correct name, and click “OK”
Close out the box “Accounts” box.

3. Here’s how the box will appear along the left margin:

4. Create a new message and cc: the archives box by typing bhl-xxxxx@umich.edu on the cc line. The message will arrive in the “Inbox.” This may take a minute or so.

5. Filing Exercises:
   a. Move a copy of a message you have received into the archives box. (Drag and Drop). By default, Outlook 2011 for Mac moves a copy of the message, leaving the “original” message in the source folder. This is indicated by a small green icon with a “+” sign appended to a representation of the file you are dragging. This is the best way to move messages into the archives. The Bentley will thus not be taking
custody of the only copy of a message, since a second copy will remain behind in your own inbox, or sent mail folder, or whatever folder you dragged the message from.

b. Besides drag and drop, there are other methods to copy a message to your archival folder.

   i. Click the “Move” button, and then select “Copy to folder.”
      Search on the name of the folder you want to move to and select this one. Make sure that the path to that folder includes the archival box name “bhl-uniqname”

   ii. You can also highlight the message, right click, and choose “Copy to folder.” It will bring up the same dialog box described in “a,” above.

   iii. You can also copy by using keyboard shortcuts:
      Shift+Command+C will bring up the same dialog box described in “a,” above.

6. Create a new subfolder within the archival box.
   - Click on either the root mailbox “bhl-uniqname” or the Inbox within this box, whichever you prefer, and right-click (or click while holding down “control”) to bring up a menu.
   - Select “New Folder”
   - Name your new folder, and make sure that it is placed correctly in the hierarchy. Click “OK”
   - By default, the access privileges from the parent folder are automatically inherited for the new folder that you have created, except that you are a co-owner of the folder (with the archivist), and have the ability to modify permissions for this folder from the default settings.
   - To modify permissions for your newly created folder:
      - n.b. This technique only allows you to set permissions for someone with at least view privileges for the parent folder.
      - To add a brand new user to the archival box, please contact Bentley Archivist Aprille McKay (aprille@umich.edu).
• Right (or CNTL) click on the new folder you have created, and click on “Sharing Permissions”

• Highlight the user whose permissions you wish to alter. Check or uncheck the boxes next to the access privileges as appropriate. This setting allows the messages to be viewed, but not refoldered or deleted.

7. Copy a group of messages from your INBOX to archives box.
   • Highlight group of messages by holding down the shift key.
   • Drag and drop into a folder in the MeMail box – bhl-uniqname.

8. MeMail archival box and Outlook Web Access.
   • Unfortunately, it is not possible to drag and drop messages from your regular Mailbox to the MeMail mailbox (bhl-uniqname) using Outlook Web Access. You can transfer a copy of a message to the archival box from within Outlook Web Access by forwarding, cc’ing, or bcc’ing the message.
   • If you use Outlook Web Access with Internet Explorer (but not Firefox or Safari), you will be able to simultaneously view both mailboxes in different browser windows at the same time – perhaps to determine
whether a particular message has been saved to the archival box. To do this, after you log on to Outlook Web Access (exchange.umich.edu), click on the down arrow next to your name in the upper right hand corner.

- In the “Select mailbox” area, enter the name of your mailbox, using the following formula: bhl-uniqname@adsroot.itcs.umich.edu, where the uniqname is replaced with the name of your box. Click “open” and another browser window will appear with access to the contents of the archival box. After you have created this the first time, the Outlook Web Access will remember and will suggest it when you start to type bhl.
MeMail Training: Pine

1) Logon to your email box
2) Locate the archival email box in the list of your folders
   a. Enter L for Folder List
   b. The mailbox is filed alphabetically under “Users”

<table>
<thead>
<tr>
<th>INBOX</th>
<th>Alpha test</th>
<th>Archival Tutorials</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benchmarking</td>
<td>Bibliography</td>
<td>Bird Center</td>
</tr>
<tr>
<td>Burns Park Players</td>
<td>Carnegie</td>
<td>Coding interviews</td>
</tr>
<tr>
<td>Current Logistics</td>
<td>Data dictionary</td>
<td>Drafts</td>
</tr>
<tr>
<td>Duff</td>
<td>Friends/</td>
<td>Friends</td>
</tr>
<tr>
<td>Genealogy</td>
<td>Isabel and Jordan/</td>
<td>Isabel and Jordan</td>
</tr>
<tr>
<td>Law and Archives</td>
<td>Metrics Book</td>
<td>Online tutorials</td>
</tr>
<tr>
<td>Partners</td>
<td>Political</td>
<td>Presbyterian</td>
</tr>
<tr>
<td>Professional</td>
<td>Publicity</td>
<td>Questionnaire</td>
</tr>
<tr>
<td>Registration</td>
<td>Research</td>
<td>Development</td>
</tr>
<tr>
<td>Standards Board</td>
<td>Student Assistant</td>
<td>Survey Software</td>
</tr>
<tr>
<td>Sustainability</td>
<td>Tibbo</td>
<td>Tin</td>
</tr>
<tr>
<td>Transaction Logs</td>
<td>Trash</td>
<td>Users/</td>
</tr>
<tr>
<td>Website</td>
<td>Yakel/</td>
<td>Yakel</td>
</tr>
</tbody>
</table>

3) Add a shortcut name for the address in the Pine address book:
   a. From main menu, choose A for Address book
b. Choose @ to add a new entry

c. Enter a nickname such as “file” and enter the address of your archival mailbox: bhl-uniqnamefile@mail.umich.edu

d. Control X to exit

e. Yes to save

4) Create a new message and cc: the archival box by typing “file” on the cc: line. Your archival file box name should automatically populate.

5) Forward a copy of a message you have received into the archival box

6) File a copy of a message you have received into the archival box
a. Using **Pine** (to move your only copy to the archival folder). Use WebMail Blue to move message in bulk, or to move copies of messages.
   i. Highlight the message you wish to save in the message index, or open the message
   ii. Enter “S” to save
   iii. Type “Users/bhl-uniqname” and enter, or if you cannot remember the name of the folder, CTRL+T and navigate by arrow keys to the folder, alphabetically, under “Users.”
   iv. Select the archival mailbox, alphabetized under “users” from the dropdown list at the center top of the screen.

b. Using **Webmail Blue**
   i. Check the box next to the message you wish to file (or next to multiple messages)
   ii. Select the archival mailbox, alphabetized under “users” from the dropdown list at the center top of the screen.
   iii. Click “Copy” to move a copy, or “Move” to remove the message from its current folder and move it to the archival box.

7) Now look at the contents of your box. You can retrieve and use any message that exists in this box as you would any message in any folder, and you can choose to delete a message that exists there whenever you wish.

8) If you use folders to manage your mail, you may know that one entire folder would be important to transfer to the archives. You can’t copy entire folders into your email box per se, but you can create a new folder in your email box, and copy or move the contents of that folder into it. Again, our recommendation is to use Webmail Blue to accomplish this task.
MeMail Training: Thunderbird

Last updated 07/07/2010, Thunderbird version 3.0.4

1) Logon to your email box
2) Locate the archival email box in the list of your folders
   a. The mailbox is filed alphabetically under “Users”

   ![Image of Users folder]

   b. If the mailbox does not appear, you may need to “subscribe” to the box. Under the “File” menu, choose “subscribe.” After a few seconds, a folder list will appear. Scroll down to “users” and expand the list of subfolders. Check the box next to the folder name “bhl-uniqname.”

3) If the record creator is comfortable moving his/her only copy of a message to the folder with a single keystroke (“A”), assign the archival box to be the default archive for archived messages.
   • From “Tools” menu, choose “Account Settings” and “Copies & Folders”
   • For the item “Keep message archives in:” choose “Other” and navigate to the archival box.

   ![Image of Keep message archives in]

   • Click “OK”
   • Now test by highlighting a message in the inbox to move to the archives, then type “A.” Navigate to the archival box, and verify that the message has been moved.

4) Add a shortcut name for the address in the Thunderbird address book:
   a. Click the Address Book, and highlight the particular address book that stores your Thunderbird contacts.

   ![Image of Address Book]

   b. Click New Contact

   ![Image of New Contact]

   c. Enter “arc” in the “Nickname” field and the address of the mailbox in the “Email” field.
d. Click “Okay”

5) Create a new message and cc the archival box by typing “arc” on the cc: line (depending on what you have chosen). Your archival file box name should automatically populate.

6) File a copy of a message you have received into the archival box
   a. Remember, if the record creator is comfortable moving the original message, all that need be done is to type “A”.
   b. Highlight the message to copy to the archival folder
   c. Right click or on a one button Mac mouse, hold down control and click. (Or – in the menu along the top of the page, select “Message”)
   d. Highlight “Copy to” and navigate to the archival box, under “Users” in your file list, and click on the command “Copy here.”
   e. After you have done this once, you can repeat the action easily by typing Shift+Cmd/Cntl+M or by accessing the “Message” menu and selecting, “Copy to “bhl-uniqname” again.
7) Now look at the contents of your box. You can retrieve and use any message that exists in this box as you would any message in any folder, and you can choose to delete a message that exists there whenever you wish.
   a. One caveat: In order for a search to find messages in the box, you must point the search tool directly to the box.
   b. To access search, highlight the archival box and type “Shift+CMD/CNTRL+F” or right click and select “search.”

8) If you use folders to manage your mail, you may know that one entire folder would be important to transfer to the archives. You can’t copy entire folders into your email box per se, but you can create a new folder in your email box, and copy or move the contents of that folder into it.
MeMail

MeMail is a University of Michigan solution for managing executive e-mail of enduring value, developed by Bentley Historical Library and Information and Technology Services (ITS)

Your archives e-mail box = bhl-andrews

Your archives e-mail address = bhl-andrews@mail.umich.edu

MeMail website: bentley.umich.edu/uarphome/memail/

____________________________________________________

sample e-mail folder listing including MeMail box

<table>
<thead>
<tr>
<th>andrews</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Budget</td>
</tr>
<tr>
<td>• Charettes</td>
</tr>
<tr>
<td>• Executive Committee</td>
</tr>
<tr>
<td>• Sent mail</td>
</tr>
<tr>
<td>• Users</td>
</tr>
<tr>
<td>• bhl-andrews</td>
</tr>
<tr>
<td>• Wallenberg</td>
</tr>
</tbody>
</table>

Your box and address were set up by ITS on April 27, 2010.

Uses of MeMail
Create, File, Retrieve, Delegate (optional)

To copy and move on Mulberry: Select messages and hold “Ctrl & Alt” as you drag and drop the message to the archival box.
**General Criteria for Inclusion in Archives Box:**

Especially historical  
Highly consequential  
Mission critical

**Suggested Categories of Content for Archives Box:**  
[Note: these terms are also suggested options for subject line]

Academic Program and Planning Evaluation  
Events  
Governance  
Presentations/Reports  
Strategic Planning  
Topical

---

Budget/Commitments  
Development  
Faculty Recruitment/Retention

**General Criteria for Exclusion from Archives Box:**

Personal  
Personnel  
Routine/Short-term value only  
Student record

**Questions/Comments?**

Contact Aprille McKay, Digital Archivist, ITS and Bentley Historical Library, aprille@umich.edu, 734.764.3482

April 2010
Importance of email

• Email is important
• Very selectively, email has long term value
• We’re conducting a pilot project to capture these records of long-term value.
• Easy, efficient and effective.

Brief overview of the method

• We can show you how it works at your desk
• A little different depending on your preferred email set-up – what programs you use, how your school or department manages email.

Demonstration

• You have a separate archival mailbox that is designated bhl (Bentley Historical Library) and then your uniqname.
• You choose to put messages in the box that are important.
  – What decisions have you made that it would be important for a successor to be able to access?
  – What would be important to be able to refer to five years from now?
  – What would be interesting to know if you were writing a history of your unit?
• We’ve created guidelines to help you understand what kinds of messages we’re interested in

Demonstration (cont)

• You can either drag and drop messages to the box from your main email box (just like it was a folder) or you can cc: or forward messages to the box because it can receive mail
• You can nominate an assistant to have access to the box as well, so you can delegate filing to the box
• You can put copies of both current and legacy correspondence in the box
• The content of the box remains in your control— you can add, delete and control who sees it, until you chose (perhaps at the end of your term) to allow the records to be downloaded and preserved by an archivist

Access to the materials

• You continue to have access to the messages while they
remain in the email system
• Once downloaded, they will be converted to preservable formats and digitally preserved in the archives
• While they are subject to FOIA, they are restricted to those with a need-to-know for 20 years and the University Records staff will protect your sensitive records

6 Why you should do it
• You have a voice in history and the latest iteration should be you.
University Archives and Records Program

Digital Archiving Infrastructure Development Plan

MeMail Project

December 2, 2010
Governance and Resourcing of Digital Records Program

Organizations cannot acquire ready-made, out-of-the-box digital preservation programs. Rather, every program is uniquely situated within its institutional context, and defined and constrained by the particular objects to be preserved and the existing technological infrastructure. Organizational readiness is a fundamental stage in the development of a digital records preservation program. The tasks listed below outline the steps UARP should take to create the infrastructure for a successful digital records program within its particular context at the Bentley Library and the University of Michigan. Loosely, they follow the steps required to process a digital object and ensure continued access over time, but they are not listed in order of importance. The goal of this document is to allow the assignment of specific tasks to team members to create the desired system.

<table>
<thead>
<tr>
<th>Task</th>
<th>Components</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Define UARP electronic records program | POLICY: Electronic Records Program Statement  
• Define the purpose, scope, and goals of UARP’s electronic records program  
• A high level document that can be referred to by other policies / plans | Related content in UARP manual and SPG. Scope of program dependent on resourcing. |
| Identify necessary staff resources for digital records program | RESOURCES  
• Institutional commitment to staffing levels for management of digital and paper records  
• Identify training needs for staff  
• Secure and commit to technical staffing for maintenance and security of systems | |
| Define policy and methodology for appraisal of digital content while it is still in the custody of creating unit | POLICY:  
• Identify the purpose of the review  
• Outline what UARP will/ won’t do when reviewing resources  
• Define UARP’s responsibilities and obligations (in regards to security or data integrity issues)  
PROCEDURE:  
• Outline steps archivists will take in reviewing repository  
• Identify necessary tools and resources  
• Include communications with units | Use ‘Memo’ text (below) as a basis  
In development |
| DOCUMENT: Memorandum of understanding  
• Explain UARP’s intentions and outline activities  
• Acquire permission to view record repositories | In development |
<table>
<thead>
<tr>
<th><strong>DOCUMENT:</strong></th>
<th><strong>POLICY:</strong></th>
<th><strong>TBD</strong></th>
</tr>
</thead>
</table>
| Electronic Records Survey  
- Gain information on units’ records, recordkeeping practices, and personnel | Articulate UARP’s goals in presenting recommendations and expected benefits for units  
- Define unit’s responsibilities in following recommendations |  |
| Form/Guide for record review  
- Establish set categories for repository reviews  
- Allow staff to document information and observations |  |  |
| Document/Guide for record review | Review and revise Records Manual and UARP website to address new technologies (e.g. s: drive procedures) |  |
| Training plan for university units that may include workshops, presentations, Green Day outreach, etc. |  |  |
| Recommendation form to prepare for meeting with individual units following targeted appraisal:  
- A template for the delivery of recommendations to units.  
- Could include predetermined categories (i.e. naming conventions, folder creation, etc.) and provide positive feedback as well as suggestions and areas for improvement | Define UARP’s responsibilities upon assuming custody  
- Determine if UARP will hold a copy or ‘the original’; will UARP just have ‘another copy’ or provide backup for units?  
- Identify preferred formats and optimal/minimal metadata to be maintained |  |
<p>| Transfer of electronic records to UARP |  | Some related content in UARP manual |</p>
<table>
<thead>
<tr>
<th>Procedure</th>
<th>Document</th>
<th>Policy</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Included with objects</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Procedure:</strong></td>
<td>In development</td>
<td></td>
</tr>
<tr>
<td>• Identify potential methods of transfer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Outline process to be followed in transfer</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Document:</strong></td>
<td>In development</td>
<td></td>
</tr>
<tr>
<td>Transfer Agreement between UARP and unit of origin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Identify files (and volume of files) to be transferred</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Define process</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Outline UARP responsibilities and liabilities</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Processing electronic records</strong></td>
<td>TBD</td>
<td></td>
</tr>
<tr>
<td><strong>Procedure:</strong></td>
<td>In development</td>
<td></td>
</tr>
<tr>
<td>Identify essential steps to take in processing electronic records</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Document:</strong></td>
<td>TBD</td>
<td></td>
</tr>
<tr>
<td>Processing template</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Guidelines for process/procedure to be filled in by archivists and graduate student processors</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Electronic records separations</strong></td>
<td>Policy: Related content in UARP manual</td>
<td></td>
</tr>
<tr>
<td><strong>Procedure:</strong></td>
<td>TBD</td>
<td></td>
</tr>
<tr>
<td>Process by which records will be deleted/removed (includes backup versions in interim repository)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Document:</strong></td>
<td>Revision of existing form</td>
<td></td>
</tr>
<tr>
<td>Separation record</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Preservation planning</strong></td>
<td>Adapt policy from Deep Blue</td>
<td></td>
</tr>
<tr>
<td><strong>Policy:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Define goals of preservation program (i.e. content and/or structure of records).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Identify preferred formats and</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


### University Archives and Records Program

#### Digital Archiving Infrastructure Development Plan

<table>
<thead>
<tr>
<th>optimal/minimal metadata to be included with objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Articulate levels of preservation</td>
</tr>
<tr>
<td>• Indicate ongoing preservation activities / issues</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DOCUMENT: Format-specific preservation plans</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Normalization strategies</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Electronic records description / requirements for digital object management database</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>POLICY:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Define level at which records will be described and the extent of those descriptions</td>
</tr>
<tr>
<td>• Identify essential metadata elements to be collected and tracked</td>
</tr>
<tr>
<td>• Determine how restricted content will be described</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DOCUMENTS/RESOURCES:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Decide if a new table in BEAL could serve our needs for a digital object management database or if there is a better solution</td>
</tr>
<tr>
<td>o Identify alternatives through conversations with library staff, ITS and/or research into other archival systems</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DOCUMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Model and define a “digital object” within our system (for example, a digital book is a collection of page images – the digital object is the book, not the individual files)</td>
</tr>
<tr>
<td>• Design the metadata schema for our objects, incorporating the output from appropriate metadata extraction tools (such as FITS).</td>
</tr>
<tr>
<td>• Determine where metadata will be tracked (what needs to be in a live system, and what could be parked with the materials)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TECHNICAL SYSTEM DEVELOPMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Map desired metadata fields to be managed in the system to data tables</td>
</tr>
<tr>
<td>• Design an ingest interface to automatically ingest metadata from XML input and track the storage location of objects</td>
</tr>
<tr>
<td>• Design an input interface to allow archivists to insert additional descriptive information such as</td>
</tr>
</tbody>
</table>

This work is dependent on policies and procedures, metadata modeling and design work.

Caveat: We would want to be able to export all data out of any system we design.

It is also impossible to know how many objects will need to be managed in this...
<table>
<thead>
<tr>
<th><strong>Access to electronic records</strong></th>
<th><strong>POLICY:</strong></th>
<th><strong>Related content in UARP manual: requires additional consideration</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Define content types subject to restrictions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Identify access restrictions and duration of restrictions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Detail methods to limit access to restricted content</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Determine how ‘open’ content will be made accessible</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Determine how restricted content will be made accessible to source units</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Define needs for “dark archive” repository:</strong></th>
<th><strong>POLICY/RESOURCES</strong></th>
<th><strong>Meet with library staff and leadership</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Determine the role of the University Library in providing long-term data storage</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Determine the role of the University Library in providing help to develop a digital records metadata management system or expertise to help us develop one in-house</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>POLICY/RESOURCES</strong></th>
<th><strong>Meet with ITS staff and leadership</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Determine the role of ITS in providing long-term data storage</td>
<td></td>
</tr>
<tr>
<td>• Determine the role of ITS in providing help to develop a digital records metadata management system or expertise to help us develop one in-house</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>DOCUMENT</strong></th>
<th><strong>Determination of cost to the Bentley of various options</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DOCUMENT (dependent on policy)</strong></td>
<td>We will need to be ready to be flexible, and to expand the amount of storage as needed. The rate of increase is also hard to determine and perhaps can only be found through lived experience.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>preservation actions, etc.</th>
<th>database – so scalability needs are hard to predict.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Design an export procedure to allow metadata to be exported in appropriate form to other descriptive systems such as MIRLYN, Finding Aid texts or Deep Blue records</td>
<td></td>
</tr>
</tbody>
</table>

Define needs for “dark archive” repository:

- POLICY/RESOURCES
  - Determine the role of the University Library in providing long-term data storage
  - Determine the role of the University Library in providing help to develop a digital records metadata management system or expertise to help us develop one in-house

DOCUMENT
- Determination of cost to the Bentley of various options

DOCUMENT (dependent on policy)
- We know the cost of Mainstream and Deep Blue. We can look into the relative costs of tape, commercial cloud storage, and potential DLPS options if any.
- We will need to be ready to be flexible, and to expand the amount of storage as needed. The rate of increase is also hard to determine and perhaps can only be found through lived experience.
<table>
<thead>
<tr>
<th><strong>POLICY</strong></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Decide whether UARP's plans should accommodate the dark archive needs of MHC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Determine how the management of the space, database system and staff be shared between the units</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Determine a governance structure for decisions about collection priorities, modifications to the system</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Define how will costs will be shared</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>POLICY / RESOURCE</strong></th>
<th><strong>TECHNICAL SYSTEM DEVELOPMENT</strong></th>
<th><strong>DOCUMENTS:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Though we plan for dark archive access to be mediated by an archivist, how granular is the &quot;live managed&quot; metadata? What does the reference archivist need to be able to search?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Though very granular access is desired, it may not be affordable. What level is tolerable?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lived experience to understand how administrative requests will need to be filled.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Build “dark archive” repository</strong></th>
<th><strong>Based on preceding requirements and budget</strong></th>
<th><strong>Confer with library personnel.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>For open content, automate the deposit to DeepBlue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disaster recovery planning</td>
<td><strong>POLICY:</strong></td>
<td><strong>TBD</strong></td>
</tr>
<tr>
<td></td>
<td>• Recovery goals (in terms of content and services)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Outline data replication / backup strategies</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>DOCUMENTS:</strong></td>
<td><strong>TBD</strong></td>
</tr>
<tr>
<td></td>
<td>• Continuity of operations, recovery strategies, emergency communications, etc.</td>
<td></td>
</tr>
</tbody>
</table>
UARP Digital Records Workflow

December 8, 2023

APPENDIX 13

All actions after ingest should be documented in preservation events (PRESERVES) at either the file level in the digital object management application, or at the accession level in MARA (TMD).

How is relationship between file versions maintained? Do we need to have IITS technical metadata, and checksums on all versions of files? If so, map this output to Digital Object App.

Can metadata be accessed? Requires agreement with archivists or does it conduct appraisal and/or file assessment?

Preservation plans for various formats?

Identify formats of records and file versions?

If so, map this output to Digital Object App.

Describe workflow in creating a Digital Object?

Link with Digital Object App?

Deduplicate digital object

Delete separation?

All actions after ingest should be documented in preservation events (PRESERVES) at either the file level in the digital object management application, or at the accession level in MARA (TMD).

How is relationship between file versions maintained? Do we need to have IITS technical metadata, and checksums on all versions of files? If so, map this output to Digital Object App.

Can metadata be accessed? Requires agreement with archivists or does it conduct appraisal and/or file assessment?

Preservation plans for various formats?

Identify formats of records and file versions?

If so, map this output to Digital Object App.

Describe workflow in creating a Digital Object?

Link with Digital Object App?

Deduplicate digital object

Delete separation?

All actions after ingest should be documented in preservation events (PRESERVES) at either the file level in the digital object management application, or at the accession level in MARA (TMD).

How is relationship between file versions maintained? Do we need to have IITS technical metadata, and checksums on all versions of files? If so, map this output to Digital Object App.

Can metadata be accessed? Requires agreement with archivists or does it conduct appraisal and/or file assessment?

Preservation plans for various formats?

Identify formats of records and file versions?

If so, map this output to Digital Object App.

Describe workflow in creating a Digital Object?

Link with Digital Object App?

Deduplicate digital object

Delete separation?

All actions after ingest should be documented in preservation events (PRESERVES) at either the file level in the digital object management application, or at the accession level in MARA (TMD).

How is relationship between file versions maintained? Do we need to have IITS technical metadata, and checksums on all versions of files? If so, map this output to Digital Object App.

Can metadata be accessed? Requires agreement with archivists or does it conduct appraisal and/or file assessment?

Preservation plans for various formats?

Identify formats of records and file versions?

If so, map this output to Digital Object App.

Describe workflow in creating a Digital Object?

Link with Digital Object App?

Deduplicate digital object

Delete separation?

All actions after ingest should be documented in preservation events (PRESERVES) at either the file level in the digital object management application, or at the accession level in MARA (TMD).

How is relationship between file versions maintained? Do we need to have IITS technical metadata, and checksums on all versions of files? If so, map this output to Digital Object App.

Can metadata be accessed? Requires agreement with archivists or does it conduct appraisal and/or file assessment?

Preservation plans for various formats?

Identify formats of records and file versions?

If so, map this output to Digital Object App.

Describe workflow in creating a Digital Object?

Link with Digital Object App?

Deduplicate digital object

Delete separation?

All actions after ingest should be documented in preservation events (PRESERVES) at either the file level in the digital object management application, or at the accession level in MARA (TMD).

How is relationship between file versions maintained? Do we need to have IITS technical metadata, and checksums on all versions of files? If so, map this output to Digital Object App.

Can metadata be accessed? Requires agreement with archivists or does it conduct appraisal and/or file assessment?

Preservation plans for various formats?

Identify formats of records and file versions?

If so, map this output to Digital Object App.

Describe workflow in creating a Digital Object?

Link with Digital Object App?

Deduplicate digital object

Delete separation?

All actions after ingest should be documented in preservation events (PRESERVES) at either the file level in the digital object management application, or at the accession level in MARA (TMD).

How is relationship between file versions maintained? Do we need to have IITS technical metadata, and checksums on all versions of files? If so, map this output to Digital Object App.

Can metadata be accessed? Requires agreement with archivists or does it conduct appraisal and/or file assessment?

Preservation plans for various formats?

Identify formats of records and file versions?

If so, map this output to Digital Object App.

Describe workflow in creating a Digital Object?

Link with Digital Object App?

Deduplicate digital object

Delete separation?
Proposed Submission Information Package and Archival Information Package – Bentley Historical Library Archival E-Mail

January 19, 2012

The Submission Information Package:
\deposit_id\ 
- folder1
  - MBOX_A
  - MBOX_B
- XML Manifest
- XML descriptive/administrative metadata (EAD)
- PREMIS spreadsheet

The developed application procedure:
- pulls content ready for deposit from our interim repository
- validates MBOX files
- extracts attachments
- extracts technical metadata and combines it with submitted PREMIS and EAD description to create a METS file
- creates unique IDs
- repackages for deposit

At the end of the procedure, the Archive Information Package is ready for deposit; it consists of:

- XML Manifest for deposit in Deep Blue
- METS file
- zipfile.zip
- MBOX_A
- MBOX_B
  \attachments-MBOX_A\ 
  \attachments-MBOX_B\
Sample METS Package for E-Mail

Bentley Historical Library
September 16, 2011

<?xml version="1.0"?>
<METS:mets xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:METS="http://www.loc.gov/METS/" xmlns:PREMIS="info:lc/xmlns/premis-v2"
xmlns:xlink="http://www.w3.org/1999/xlink"
xmlns:HT="http://www.hathitrust.org/premis_extension"
OBJID="bhlnamespace.some_identifier"
xsi:schemaLocation="http://www.loc.gov/METS/
http://www.loc.gov/standards/mets/mets.xsd http://www.loc.gov/MARC21/slim
http://www.loc.gov/standards/marcxml/schema/MARC21slim.xsd
info:lc/xmlns/premis-v2 http://www.loc.gov/standards/premis/v2/premis-v2-0.xsd">

  <METS:metsHdr ID="HDR1" CREATEDATE="2011-09-17T11:15:26"
RECORDSTATUS="NEW">
    <METS:agent TYPE="ORGANIZATION" ROLE="CREATOR">
      <METS:name>DLPS</METS:name>
    </METS:agent>
  </METS:metsHdr>

  <METS:dmdSec ID="DMD1">
    <METS:mdWrap LABEL="Collection description EAD" MIMETYPE="text/xml" MDTYPE="EAD">
      <METS:xmlData>
        <ead>
          <eadheader audience="internal" langencoding="ISO-8859-1" repositoryencoding="iso15511"
dateencoding="iso8601" relatedencoding="Dublin Core"
scriptencoding="iso15924" countryencoding="iso3166-1">
            <eadid countrycode="us"
mainagencycode="MiU-H" publicid="us//::miu-h//TXT us::miu-
h::filename.xml//EN" encodinganalog="Identifier">ID for this deposit, collection id
plus a Deep Blue Deposit number/date that matches OBJID above?</eadid>
          </eadheader>
          <filedesc>
            <titlestmt>
              <titleproper encodinganalog="Title">title of this deposit</titleproper>
            </titlestmt>
            <publicationstmt>
              <publisher>Bentley Historical Library</publisher>
            </publicationstmt>
          </filedesc>
        </ead>
      </METS:xmlData>
    </METS:mdWrap>
  </METS:dmdSec>
</METS:mets>
<date encodinganalog="Date" normal="2009">date of deposit</date>
</publicationstmt>
</filedesc>
</eadheader>
<archdesc level="collection"
audience="external" type="inventory" relatedencoding="MARC21">
<did>
<origination>archival record group creator</origination>
<unittitle encodinganalog="245">archival record group title</unittitle>
<unitdate type="inclusive" encodinganalog="245$f">date range of material</unitdate>
<unitdate type="bulk" encodinganalog="245$g">bulk date range</unitdate>
</unittitle>
<physdesc>
<extent encodinganalog="300">size (no. of files/ bytes?)</extent>
</physdesc>
</physdesc>
<physfacet>statement about file formats, etc</physfacet>
</physdesc>
<unitid encodinganalog="852$h" repositorycode="miu-h" countrycode="us" type="call number">collection ID</unitid>
<langmaterial>
<language langcode="eng">English</language>
</langmaterial>
<abstract>ABSTRACT</abstract>
</did>
<descgrp type="admin">
<acqinfo encodinganalog="541">
<p>ACQUISITION</p>
<num type="donor">XXX</num>
</acqinfo>
<accessrestrict>
<p>access status</p>
</accessrestrict>
</descgrp>
</archdesc>
<PREMIS:eventDetail>Calculation of file checksums</PREMIS:eventDetail>

<PREMIS:linkingAgentIdentifier>
  <PREMIS:linkingAgentIdentifierType>MARC21 Code</PREMIS:linkingAgentIdentifierType>
  <PREMIS:linkingAgentIdentifierValue>MiU-H</PREMIS:linkingAgentIdentifierValue>
  <PREMIS:linkingAgentRole>Executor</PREMIS:linkingAgentRole>
</PREMIS:linkingAgentIdentifier>

<PREMIS:linkingAgentIdentifier>
  <PREMIS:linkingAgentIdentifierType>tool</PREMIS:linkingAgentIdentifierType>
  <PREMIS:linkingAgentIdentifierValue>Digest::MD5 2.36</PREMIS:linkingAgentIdentifierValue>
  <PREMIS:linkingAgentRole>software</PREMIS:linkingAgentRole>
</PREMIS:linkingAgentIdentifier>

<PREMIS:event>
  <PREMIS:eventIdentifier>
    <PREMIS:eventIdentifierType>UUID</PREMIS:eventIdentifierType>
    <PREMIS:eventIdentifierValue>13093CC0-9460-314B-931C-425F01C105B3</PREMIS:eventIdentifierValue>
  </PREMIS:eventIdentifier>
  <PREMIS:eventType>validation</PREMIS:eventType>
  <PREMIS:eventDateTime>2011-03-16T16:50:54</PREMIS:eventDateTime>
  <PREMIS:eventDetail>Validation of object components</PREMIS:eventDetail>
  <PREMIS:eventOutcomeInformation>
    <PREMIS:eventOutcome>pass</PREMIS:eventOutcome>
  </PREMIS:eventOutcomeInformation>
</PREMIS:event>

<PREMIS:linkingAgentIdentifier>
  <PREMIS:linkingAgentIdentifierType>MARC21 Code</PREMIS:linkingAgentIdentifierType>
  <PREMIS:linkingAgentIdentifierValue>MiU</PREMIS:linkingAgentIdentifierValue>
  <PREMIS:linkingAgentRole>Executor</PREMIS:linkingAgentRole>
</PREMIS:linkingAgentIdentifier>

<PREMIS:linkingAgentIdentifier>
  <PREMIS:linkingAgentIdentifierType>tool</PREMIS:linkingAgentIdentifierType>
  <PREMIS:linkingAgentIdentifierValue>bentley_ingest.pl</PREMIS:linkingAgentIdentifierValue>
  <PREMIS:linkingAgentRole>software</PREMIS:linkingAgentRole>
</PREMIS:linkingAgentIdentifier>
Does your university archives have born-digital records? Share how you are effectively managing these digital records by submitting a case study to Campus Case Studies. Visit www.archivists.org/publications/epubs/CampusCaseStudies/.